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1 Introduction

1.1 Overview of MonitorWare Console

1.1.1 MonitorWare Console

MonitorWare Console provides great reporting, a centralised view of network
events and many helpful tools to ease your life as a system administrator. It
works together with the other of Adiscon's MonitorWare line of product as
well as with many third-pary logging solutions.

MonitorWare Console is the a member of Adiscon's MonitorWare line of products. It's a
user-friendly, graphical interface for log viewing and analysis.

With MonitorWare Console, network administrators can quickly watch what is going on
in the network. It also enables security administrators to find weak spots and aids in
detecting intrusions as well as forensic analysis.

If you would like to contact Adiscon, please email us at support@adiscon.com for
technical questions and info@adiscon.com for all others.

1.1.2 Features

Flexible Reporting

MonitorWare Console ships with several pre built great reporting options and users
can create and add their own custom reports by applying various filters. Reporting
sub-system is based on Crystal Reports. Besides the Crystal format (.rpt) it allows to
generate reports in your prefered format like .pdf or .xls for example.

Reports are now available in two flavors i.e. Pix Reporting Module and Windows
Reporting Module. Additional there are so called Bonus Reports available.

Customizeable Views

Users can define their own views of the data in a system. MonitorWare Agent logs the
data to a central database and MonitorWare Console allows users to view that data in
various combinations.

Report Generation using Data Sources

MonitorWare Console can generate intelligent reports using Data Sources. This means
multiple data sources regardless if it is a database or text file can be use for
generating a report.

Knowledge Base

Keep and track important notes, technical details or articles regarding your system in
one centralized Knowledge Base. Search articles against specific system events and
devices in your network.

Track System Devices
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Keep track of all the machines and devices in your network by creating a profile for
each. MonitorWare Console also helps discovering new reporting devices that have
reported to MonitorWare database.

Tools

MonitorWare Console comes with various tools that help the network administrator.
As a user, you have the option of using the following tools:

1.) ICMP Lookup Tool

2.) Database Maintenance Tools
· Delete Records Tool
· Backup Records Tool
· Retrieve Records Tool
· Create / Remove Indexes Tool

3.) Network Tools
· Ping Tool
· TraceRoute Tool
· PortScan Tool

4.) Export / Import Database Settings Tool

Job Manager

MonitorWare Console comes with a Window service that is called Job Manager. Job
Manager is a very powerful feature that has the capability of generating reports
according to your defined schedule. You can also ask the Job Manger to generate the
reports at the specified time and then send them to your specified recipients via email
or save it to a web server folder for example.

Time Zone Handling

MonitorWare Console provides transparent handling and conversion of time zone
related issues in a geographically spread system. All system-generated events are
logged after converting to UTC time and are retrieved and displayed to the users in
their configured time zones. Thus, users always get to view and analyze the data in
their own time zones.

Database Support

MonitorWare Console supports Microsoft Access, Microsoft SQL Server and MySQL
databases. Support for SQL Server also implies that MonitorWare Console and
MonitorWare Agent can be used with the free version of this product, i.e. MSDE.

User management

You can create different user profiles and can select various time zones for them. The
data will be converted to the local time based on the specified UTC Offset.
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Localization Support

MonitorWare Console can be localized to any of the world languages, including right-
to-left scripts like Hebrew and Arabic. End users can request Adiscon to provide
support for a particular language or even translate and localize the product
themselves – using step by step instructions provided by Adiscon on request.

1.2 Components

1.2.1 MonitorWare Console

MonitorWare Console is an analysis tool that builds on top of the MonitorWare Central
Data Repository that has been gathered either by MonitorWare Agent or by
WinSyslog. It ships with several pre-built reports, pre-defined views and a sample
database for immediate testing after setup.

Depending upon the size of the network and the auditing policy, MonitorWare Agent
or WinSyslog gather huge amount of data in the central MonitorWare Data Repository.
All of this data will be meaningless to the network administrator if he/she is not able
to analyze it properly. In fact, such huge amount of data cannot be analyzed
manually. You need to have some great tool that could extract important information
from that huge data repository. MonitorWare Console is the tool that would help you
out in this analysis. With MonitorWare Console, you can view many reports which
have been made after extensive research in data analysis field. These reports provide
you with great information that would help you out in identifying the problematic
areas in your network. We, at Adiscon, are totally "Customer Oriented". Addressing
the needs of the customers is our top most priority. We keep this philosophy in mind
at all times. We have even developed MonitorWare Console keeping this philosophy in
mind. It means that if you require any specific report that is not currently present,
you can simply contact support@adiscon.com and tell us your requirements. We will
create exactly the report in which you are interested if possible and will ship that
report to you. You will simply place it in the specified folder and it will become part of
MonitorWare Console without re-installation or any other configuration changes.

Apart from the reporting module, you can take advantage of the Views module in
Console. In this module, you can define your own views. The data is displayed in the
form of hierarchies which help in a great understanding of the otherwise meaningless
data. Once again, keeping our "Customer Oriented" philosophy in mind, we have
developed this module, again, in such a way that if you are feeling problems in
creating a view, you can contact us and we can make that view for you absolutely for
free and will ship the required view to you. You will simply place it in the specified
folder and it will become part of MonitorWare Console without any hassle.

There are many other modules in MonitorWare Console which you will see in detail as
you read this manual. Since there are many modules in MonitorWare Console and
each one of them is not necessarily required by all customers, so we have designed
MonitorWare Console in such a way that only those modules could be purchased in
which you are interested. With this approach, we have ensured that our valuable
customers only pay for the specific functionality in which they are interested in, and
hence reducing the cost.

MonitorWare Console has been divided into following 7 sub modules for efficient and
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cost effective working:

1. Base Product (This has to be purchased in order to use other modules)
2. Network Scanning Tools
3. Windows Reporting Module
4. PIX Reporting Module
5. Knowledge Base Module
6. Devices' Module
7. Views Module

Important Note: Although MonitorWare Agent and WinSyslog are not components of
MonitorWare Console directly,  MonitorWare Console will be mostly useless without
them. The reason is that the MonitorWare Console performs all of its analysis on the
data that has been gathered by either MonitorWare Agent or WinSyslog and logged
into MonitorWare Central Data Repository. The reporting module, however, is also
able to use different data sources, so

1.3 System Requirements

· The client machine must be Microsoft .NET 2 ready in order to run the MonitorWare
Console application. Thus, the machine must at least meet the minimum hardware
requirements for hosting .NET framework. The setup program will install the .NET 2
runtime files and other dependencies.

· For a list of hardware and software requirements for .NET 2 visit
Microsoft Website: System Requirements for Version 2.0 

· MonitorWare Console requires around 20 MB of hard disk space for the Core Console
files when installed. This includes provision for sample Access database that
consists of around 45,000 records of sample event data. Additional hard disk space
required for other Core components: 600-1000 MB.

· Some modules of MonitorWare Console are quite memory and processor intensive,
like Reporting and the Views modules. A Pentium III-class processor and at least
512 MB of RAM are suggested for good performance; however, MonitorWare Console
will work with much less.

· In order to process Windows Events - these must be transported via SETP. SETP
protocol is not only essential for Windows Reporting Module but also for the
Views Module.

· The Latest Version of MDAC (Microsoft Data Access Components) is required. Or
Simply visit the Microsoft Download Center for knowing that what is the latest
verison of MDAC. Of this writing the latest version of MDAC is 2.8 SP1. Click here to
download the 2.8 SP1 Version.

http://msdn2.microsoft.com/en-us/library/ms229070.aspx
http://www.microsoft.com/downloads/search.aspx?displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=78cac895-efc2-4f8e-a9e0-3a1afbd5922e&DisplayLang=en
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2 Getting Started

2.1 Setup

Installing the MonitorWare Console is simple and easy. A standard setup program
installs the application.

There are a number of different download versions of the product available. The main
difference is whether or not a current version of the Microsoft Windows Installer
program is included. If you use recent software (e.g. Windows XP or Windows 2003
Server), you can typically use the small install set. Install sets have different names.
Those ending in "max" are typically the version for older operating systems without a
current installer. If in doubt, use an install set whoms name ends in "max". All files
are direct install sets, so there is no need to unzip them to find a setup.exe or such.

Depending on the download directory, the setup program may also be supplied in a
ZIP file.

2.2 Running Console the First Time

Figure 1: Console Configuration Wizard startup screen

When you start MonitorWare Console for the first time, the Configuration Wizard will
be automatically executed. With this wizard you configure the most necessary
functions of MonitorWare Console. Hit the "Next" button to start.
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Figure 2: Database setup

On this screen (Figure 2) you have to configure in which database MonitorWare
Console should store it's configuration data. This is very important. You can either
create or choose another database. For this click on "Edit..." and choose or create the
database with your needs with the "ODBC Data Source Administrator"-Interface. Or
you let MonitorWare Console save it's settings into the standard sample database
which comes with Console. For this just leave the settings as they are by default.

If you choose to use a different database than the default one for saving the Console
settings, then you have to insert the correct DSN that your db has and of course
UserName and Password if required. After entering the correct settings, just hit "Next"
to continue.
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Figure 3: Update Database:

The next step is to update the database structure. MonitorWare Console needs in
order to save it's settings some specific tables. This can be easily done by hitting the
"Update Database" button. If you use your own database we strongly suggest to
create a backup before updating the database. After this is done, go on to the next
step.
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Figure 4: User Management Interface

There is one standard user implemented in MonitorWare Console. That is the
Administrator. By default no password is set (this means it is nothing entered in the
password field). You can set a password now and adjust the other information if you
want. Is it also possible to add other users at this stage if necessary. If you are ready
with the user settings click "Next" to proceed.
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Figure 5: Finishing the first Setup

Now you have nearly made it. Simply hit the "Finish" button to complete the basic
setup of MonitorWare Console. After that you should see the loading screen of the
Console and when it is done loading the main screen should appear. For further
information on the main interface, please read: The Main Form. Now the basic
settings are done. Go on with regular startup of the Console.
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2.3 Regular Startup of Console

Once the first setup of MonitorWare Console is done and you start it for regular use, a
dialog box similar to the one shown in figure 1 will be displayed.

Figure 1:  MonitorWare Console: Startup Dialog Box

The default user name is "admin" without a password (this means it is nothing
entered in the password field). Once a user enters into the application, this password
can be changed.

At the bottom left corner of this dialog box, there are three links "Update Database",
"Edit Settings" and "License Options" The latter one is self-explanatory. If you click on
it, a license dialog appears where you can view or change your license key and license
name. There is also a link to order the product directly via our online ordering system.
Please note that MonitorWare Console has Modular Licensing now. For getting more
details on License, please see License Options
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Figure 2: Licence options Dialogue Box

The other link in the login dialog, "Edit Settings" is used if the user wants to change
the database connection or other settings. Currently MonitorWare Console supports
Microsoft Access, SQL Server and MySQL. Once the above mentioned link is clicked, a
dialog box, as shown in figure 3, will pop up. Using this dialog box, the user can
change the underlying database or other settings. All settings from standard program
settings over to custom report settings will be stored in this database.
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Figure 3: Dialog Box to change the underlying database

For details about this dialog box, please see General Settings

After saving the settings, click on OK. This will take you back to Figure 1.

And finally there is the "Update Database"-Button. When you click it, you should
receive the follwoing dialog:

Figure 4: Database Update Dialog

Choose "yes" for giving the DB an update with the current settings, tables etc. Choose
"no" or "cancel" and the operation will be aborted.

Note: This is an important action. Because if the database doesn't contain the
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correct tables, then the program cannot save any of its settings in there.

After you click OK on the main screen, the following cases could happen:

Seven Cases that can happen when starting MonitorWare Console

Case 1: Your login and password is validated and is correct and there is no update
required for the underlying database that you set in Figure 3. If this is the case, you
will enter MonitorWare Console successfully and you will see a form similar to the one
shown below:

Figure 5: Main Form of MonitorWare Console

Case 2: Your login and password fails because you have either entered wrong login
and wrong password. If this is the case, you will stay on this dialog box and it will ask
you for the correct login and password again. Following message box will be displayed
to you:
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Figure 6: Login Fail Dialog

Case 3: Your database to which the DSN in figure 3 is pointing to is not a valid DSN.
By valid DSN, we mean that the DSN is not pointing to the database that contains
SystemEvents table. In this case, you will get the following message box:

Figure 7: Invalid Database

Case 4: Your database to which the DSN in figure 3 is pointing to is valid but you
dont have sufficient permissions to query it. In this case, once again a dialog box
similar to the one shown in figure 7 will be displayed.

Case 5: The Error in Figure 7 is displayed when the latest version of MDAC (Microsoft
Data Access Components) isn't installed. Please make sure that you have got the
latest version of MDAC. For details see the
System Requirement section.

Case 6: You don't have sufficient permissions to write something to the registry. In
this case, again a dialog box complaining that you dont have sufficient permissions
will be displayed to you.

Case 7: Your login and password is valid and your DSN is pointing to the correct
MonitorWare database but the database is old. MonitorWare Console will display you a
messagebox which asks you if you want to update your database settings. If you click
on Yes, the database will be updated (because console needs some additional tables
for house keeping). If you click on No or Cancel, the dialog box will disappear taking
you to the main dialog in figure 1.

2.4 Obtaining a Printable Manual

A printable version of the manual can be obtained at
http://www.monitorware.com/en/Manual/

The manuals offered on this web page are in PDF format for easy browsing and
printing. The version on the web might also include some new additions, as we post
manual changes – including new samples – frequently and as soon as they become
available.

3 Using MonitorWare Console

MonitorWare Console now comes with multiple license options. This means that you
don't have to purchase the overall product. Obviously the needs of various customers
are different. We, at Adiscon, always keep our customers in mind. With this multiple
license approach, you don't have to pay for those things in which you are not
interested. You can simply order for those modules that best suit your needs and

http://www.monitorware.com/en/Manual/
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hence this reduces the cost tremendously.

MonitorWare Console comes with the following modules:

1.) Base Product (This has to be purchased in order to use other modules)
2.) Reporting Modules
3.) The Views Module
4.) Network Scanning Tools
5.) The Device Module
6.) The Knowledge Base Module

3.1 General Things

3.1.1 Main Form

Once inside the main application, user will see a form similar to the one shown in
Figure 1. The Main Form contains the following:

1.) Menu Bar
2.) Tool Bar
3.) Tree View
4.) Main Area (where all child forms would be displayed)
5.) Tree Nodes
6.) Status Bar

Figure 1: MonitorWare Console: Main Form
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Introduction to the components of Main Form

Menu Bar: It contains sub menus, which will take the user to different modules
present in this application.

Tool Bar: Tool bar has a number of different buttons on it and it also does more or
less the same thing as done by sub menu items in the menu bar. Clicking on these
buttons would take the user to another module of this application.

Tree View: The left region of the application is the Tree View, which displays
different Tree Nodes in it.

Tree Nodes: When the application starts, it displays 4 main tree nodes. Clicking on
any of them would take the user to the respective module.

Main Area: The gray region in the center is currently not showing any thing. When
any of the nodes from the tree view is clicked, or a button from the tool bar is clicked,
or user selects some sub menu item from the menu bar, it displays the main form,
corresponding to the selected module.

Status Bar: It informs the users about important messages through out the
application usage.

Job Manager: The round Dot to the left here indicates the status of the JobManager.
Green means it's running and red means it's stopped. The buttons following each
have a function. The first button opens the JobManager Menu in which you can
configure JM. The second button switches JM into running state as the third button
stops it. The fourth button initiates a stop/start action which lets you restart the JM
with only one click.

3.1.2 Options

Once you click on the Options Menu, the following options are displayed as shown in
the dialog. Options available are:

1.) General Options
2.) Manage Users
3.) Time Zones
4.) Web Search URLs
5.) Common View Settings
6.) Job Manager Settings
7.) MonitorWare Console License Options
8.) EventID.net License Options
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Figure 1: Options Menu
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3.1.2.1 General Options

3.1.2.1.1  General

Once you click on the General Options the following screenshot is displayed:

Figure 1: General Tab

Display Login Dialog at Startup
If checked the dialog box in figure 2 appears every time at the startup of the
MonitorWare Console application. If unchecked it will directly take you into the
Monitorware Console main application without displaying Figure 2.
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Figure 2: Main dialog

Note: The dialog in Figure 2 would appear irrespective of the setting of the above
checkbox if:

1.) The underlying database used by MonitorWare Console needs to be
updated.

2.) MonitorWare Console can't connect to the underlying database.
3.) Login and Password aren't correct.
4.) If the Base Product has expired.

DSN
This field is mandatory. This will point to the DSN of the database which will store all
the settings related to the MontitorWare Console . And later on this will work as the
underlying database to which MonitorWare Console is connected.

Edit
This option opens up a dialog box for creating the DSN. A dialog similar to the one
displayed opens where you can configure the settings according to your environment.
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Figure 3: Dialog Box to create a DSN

Once the provider and the connection has been selected, Test Connection button can
test whether the connection with the specified database has been established or not.

If the dialog box, as shown in figure 4, is displayed, it means that the connection with
the specified database has been set up properly and the user can proceed further by
pressing the OK button
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Figure 4: Success dialog

On the other hand, if a dialog box appears which means that there is something
wrong and the connection with the mentioned database has not been established,
please re-check all your settings.

User Name
This option allows you to configure the User Name for connecting to the database.

Password
This option allows you to configure the Password for connecting to the database.
Note: If you had created the DSN with the "Windows Integerated Security", then you
don't need to give any user name or password.

Debug Options
You have several debug options available here. First off you can create separate
debug logs either for the MonitorWare Console Client and/or for the Job Manager
Service. Each one has the same set of options. When the little checkbox is marked
you can configure the debug output. You can specify where those logs should be
saved and you can choose the type of message that is to be logged (e.g. only simple
info messages, warnings and errors or the full pack of everything in detail). This
option is quite useful for troubleshooting and is especially important for our support.

OK
Saves the settings and quits the form.
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Cancel
Quits the form without saving the settings.

3.1.2.1.2  BackgroundTasks

By clicking on the "Background Tasks" Tab in the General Options, you will see the
following:

Figure 1: Background Tasks Tab

Enable Background Index Optimizer

If checked, an optimizer is watching database access. If a "View" needs longer to
prepare than "Minimum Idle Time" a popup appears. Asking if database tables should
be indexed in order to get a better performance.
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Minimum Idle Time

Time in seconds the Index Optimizer should wait until it fires. The optimizer will only
run if the runtime of a "View" is higher than Minimum Idle Time.

Enable Background Database Cleanup

If enabled a background mechanism periodically checks if there are old records in the
database which should be deleted.

Minimum Idle Time

The time interval in seconds the Background Database Cleanup checks for old records.

Delete records older than 'x' days

This option allows you to delete all of the records older than 'x' number of days where
x is user defined.

On the basis of

This option allows you to delete on the basis of DeviceReportedTime and ReceivedAt
Time (these fields are defined in the SystemEvents Table).

Note: DeviceReportedTime and ReceivedAt Time are different from each other.

The DeviceReportedTime is actually the time that is there in the Windows Event Log
i.e. the time at which the (e.g. syslog) message was written into the Windows Event
Log.

ReceivedAt time on the other hand is the time when the (e.g. Syslog) message is
received at the configuration program e.g. MonitorWare Agent.

3.1.2.2 Manage Users

To create, update or delete a user for MonitorWare Console application, Manage Users
form is used. This form can be opened in one of the following ways.

1.) Click on Options button the main tool bar and then select "Manage Users".
2.) Go to Tools menu and select options. In options, you will find "Manage
Users" item.

After the user has selected one of the above-mentioned methods, the following form
will open up.
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Figure 1: Manage Users Form

Notice that Login text field, User Type combo box, New, Add, Delete and Refresh
buttons are disabled. The reason is that this snapshot has been taken when a regular
user (not administrator) was logged on to this application. In other words, if a normal
user enters into MonitorWare Console application he can only update his status
(except for login and user type). On the other hand, if the user enters into this
application as an administrator, then he has the full control on all the users. He can
create a new user, delete an existing user or update an existing user.

Following is a brief summary of each component on this form:

· Display Name: The text written in it will be used as the display name for the user .

· Login: The text written in it will be the actual login of the user that will be used in
the User Verification form when the application is started (available for
administrator only).

· Password: Contains the password of the user.

· Re-enter Password: When creating a new user, make sure that Password and Re-
enter Password text fields have the same contents.

· User Type: Can either be an administrator or a simple user (available for
administrator only).

· Language: In the current version, only English can be selected.

· Last Login: Displays the last login date and time for the selected user.



28 MonitorWare Console

© 2006 Adiscon GmbH

· Time Zone: Displays the time zone of the selected user.

· Users: The list box "Users" displays all the users that can use this application.

· New: This button is used to create a new user (Available for administrator only).

· Add: This button adds a new user (available for administrator only).

· Delete: This button deletes selected user (available for administrator only).

· Update: This button updates an existing user.

· Refresh: Refreshes the list of users from the database.

· Close: Closes the "Manage Users" form.

3.1.2.3 Time Zones

Time zones can be modified by one of the following ways:

1.) Click on the Options button and then on Time Zones menu in the main tool
bar.

2.) Go to Tools menu and select options. In options, you will find "Time
Zones". Click on it to open up the Time Zones form.

After the user has selected one of the above-mentioned ways, a dialog box, similar to
the one shown in the figure 1 would be displayed:
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Figure 1: Time Zones

A brief summary of all of the components on this form is given below:

· Short Name: Specifies a short name for this Time Zones.

· DS Short Name: Specifies a short name for DS Name.

· Name: It displays the name of the currently selected time zone.

· DS Name: Specifies a name for Daylight saving time.

· Offset UTC: It tells the difference of the current time zone from GMT in minutes.

· Offset DS: Daylight saving time offset.

· DS Begin Date: Date when Daylight saving time starts.

· DS End Date: Date when Daylight saving time ends.

· New: This button is used for creating a new time zone.
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· Add: This button is used for adding the newly created time zone to the database. It
only works after pressing the "New" button.

· Delete: It deletes the selected time zone permanently from the database.

· Update: It updates an existing time zone.

· Close: Closes the Time Zones Manager.

The changes made from this form will be visible in the Time Zone combo box in the
Manage Users form as well.

3.1.2.4 Web Search URLs

If you click on Options -> Web Search URLs, you will see a dialog box similar to the
one shown below:

Figure 1: Web Search URLs

Using this form, you can define your query strings (URLs) that will be used for
searching of a particular thing from the views form or from the devices form by
clicking on the "Web Search" button.

Select Criteria List

This list can be used to add a tag to the URL. For example, if "$EventSource" is
double clicked, it will move in the URL text field. Now when you use the above
mentioned URL to search, it will replace "$EventSource" with the "EventSource" value
for that particular event in the views form. Similarly, you can define the combination
of different criteria as well as shown above in the URL List. This list will be displayed
when you press the Down Arrow on the Web Search button as shown below:
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Figure 2: Web Search Button

The list that you can see above, is actually the list that you have defined in Figure 1.
So it is recommended, that you use meaningful names for each query string so that
you know that when I click on a particular query string, it will look for what.

The fields used in this form are described below:

Insert

Insert is used to insert a new entry of URL to the URL list.

Update

Update is used to update some existing entry of the URL in the URL list.

Delete

Delete is used to delete some existing entry of the URL in the URL list.

Refresh

It simply refreshes the URL list from the database.

URL List

It displays all existing entries of the URLs.
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Close

Closes the form.

3.1.2.5 Common View Settings

In this module, there is a concept of Global Settings. Global Settings are the settings
that will be applied to all the newly created views by default, although you have the
flexibility to modify them for each view definition individually. To initialize Global
Settings or Common View Settings, go to the Options Button in the Main Tool bar and
click on "Common View Settings". A dialog box similar to the one shown in the
following figure will open up:

Figure 1: Common View Settings (General Tab)

This dialog box has five tabs. The following sections will describe each tab in detail.

Important Note: Please note that the filters defined in "Device Filter" tab,
"InfoUnit Filter" tab and "Time Filter" tab will be ANDed together
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3.1.2.5.1  General Settings

On this Tab, you can specify Page size and Data Sort Order.

Figure 1: Common View Settings - General Tab

Page Size: Page size is the maximum number of records that a user can see on one
page in the data grid. If the number of records brought by the query is greater than
the page size for that view, user has the option of pressing the "Next" button (will be
explained in the coming sections) to go to the next page. In short: at one time, the
user will not be able to see records greater than "Page Size" specified in this tab.

A paging algorithm has been implemented in MonitorWare Console to improve
efficiency. Had there been no paging algorithm, then the data grid had to display ALL
the records that are returned from the database (imagine 1 million records being
returned) and the user had to wait for a very long interval of time to see the results.
The paging algorithm only brings those many records at one time that are specified in
the page size. So greater the page size, the more will be the time for each page to be
displayed because of more number of records that are to be brought from the
database but the total number of pages would be less. On the other hand, if the page
size is kept small, then less time will be taken for each page to be displayed because
a lower number of records are to be brought from the database but this will increase
the total number of pages. Depending upon your requirements, you should make
some compromise between these two options and set the page size accordingly.

Data Sort Order: This is the sort order according to which the data will be brought in
the data grid. Currently this sorting is applied on the ID column.
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3.1.2.5.2  Column Selection

Pressing the "Next" button at the bottom of the dialog box, or pressing the "Column
Selection" Tab from the top, will take you to the next page as shown below:

Figure 1: Common View Settings (Column Selection Tab)

This tab will allow you to select the columns that you want the application to show in
the data grid when a view is executed. Simply check the columns that you want to
see in a view. This tab also gives you the flexibility of changing the names of the
columns. Double clicking on any item in the list view will open up another dialog box,
in which you can specify the display name for that column. You also have an option of
changing the order in which the columns should appear on the grid by pressing the up
and down buttons present on the right side of the above form. The top most column
displayed in the above form will be the first column that will be displayed in the data
grid when the view is displayed and bottom most (Selected column) will be the last
column (on extreme right side) on the grid.
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3.1.2.5.3  Device Filter

Pressing the "Next" button at the bottom of the dialog box, or pressing the "Device
Filter" Tab from the top, will take you to the next page as shown below:

Figure 1: Common View Settings (Device Filter Tab)

With this tab, you can specify a filter based on devices. If you do not want to apply
this filter, simply check the check box. If you want to apply the filter, you would have
to first uncheck the checkbox because otherwise the list box would remain un-
editable.

Select the device on which you want to apply the filters. All the devices that you will
select from the list box will be ORed together. E.g. If you have selected WS01 and
WS03 from the above list, then it will bring all the records where device name is
either WS01 or WS03.
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3.1.2.5.4  Info Unit Filter

Pressing the "Next" button at the bottom of the dialog box, or pressing the "Info Unit
Filter" Tab from the top, will take you to the next page as shown below:

Figure 1: Common View Settings (Info Unit Filter Tab)

With this tab, you can specify filters based on Info Units. If you want to apply the
filter, you would have to uncheck the checkbox so that the list box is enabled. As
mentioned above in the Devices Tab, the Info Units that you have selected from the
above list will be ORed together.
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3.1.2.5.5  Time Filter

Pressing the "Next" button at the bottom of the dialog box or pressing the "Time
Filter" Tab from the top will take you to the next page as shown below:

Figure 1: Common View Settings (Time Filter Tab)

Using this tab, you can specify filters based on time. If you want to apply time-based
filters, you would have to uncheck the check box at the top to enable the options
below. You have two options to apply filters in this case.

Note: Both of these options are mutually exclusive. If you select the above
radio button, then the filter would be applied on the basis of "Records logged
during last" option and if the lower radio button is selected then the filter
would be applied on the range that you will specify in the from and to date
time picker combo boxes. However, both of these filters cannot be applied
simultaneously.

3.1.2.6 Job Manager Settings

Please see the Manual Section regarding Job Manager for further Informations.
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3.1.2.7 MonitorWare Console License Options

There are two ways of accessing this License form.

1.) Starting Console and clicking on "License Options" Link on bottom left.
2.) Clicking on Options -> MonitorWare Console License Options in the main
form of MonitorWare Console.

In any case, it will open up a dialog box similar to the one shown below:

Figure 1: Licence options Dialog Box

In this dialog, you can view/enter information related to the module name, license
name and license key. There is also a link (i.e. Order Now Button) to order the
product directly via our online ordering system.

MonitorWare Console now comes with a different licensing structure. MonitorWare
Console license structure has been splitted into two essential parts that is:

1.) Base Product Key
AND

2.) Your Required Module Key

The modules which are shipped with MonitorWare Console are:

1.) Device Module
2.) Knowledge Base Module
3.) Windows Reporting Module
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4.) Pix Reporting Module
5.) Views Module
6.) Network Scanning Tools

The base product and every module calls for an individual license. This approach has
been adopted keeping in mind the customer's ease. Another reason for adopting this
approach is for reducing the total cost of the product for the end user.

For example a customer might be interested in the Windows Reporting Module only
and the other modules of the MonitorWare Console are of no use for him. So why
should he pay a high cost for the modules in which he isn't interested? With the
convention that we have adopted the customer wouldn't pay for the modules that he
is not interested in. In the quoted example the customer would need the Base Product
plus the Windows Reporting Module only.

Note 1: You have to buy the Base Product Key (mustbe), as without it you
will not be able to use the MonitorWare Console  application.

Note 2: All modules are shipped with MonitorWare Console  but these are
available only when the license for a specific module is entered.

MonitorWare Console either runs in:

1.) Licensed mode
OR

2.) Trial mode

Download MonitorWare Console from the following URL:
http://www.mwconsole.com/en/Download/

Once you have downloaded and installed MonitorWare Console, the base product and
all the supported modules will run in a trial mode (i.e. for 30 days).

Once the trial period is over you can't use the application any more. You have to buy
the license key for the base product plus the license key for the modules in which you
are interested.

Note: Please bear in mind that if for some reason the Base Product has
expired (trial period is over or the license has expired), you will not be able
to use the other modules or features of MonitorWare Console (even if the
modules are licensed). MonitorWare Console Base Product should be running
in licensed or trial mode for accessing these modules and features.

Note: Trial keys follow the same set of rules as defined for the license i.e. the
base product and all modules calls in for an individual trial key.

In the Main Form there is a "Request Trial" Button. The following example will help
you to better understand how the request trial button works.

We assume that you have downloaded and installed MonitorWare Console on 1
st

/Jan
(to be more specific). Since the application is running in a trial mode it will expire
after 30

th
/Jan. Once your copy of MonitorWare Console is expired, you can't access

the application as the Base Product has expired. A dialog as shown below will be

http://www.mwconsole.com/en/Download/
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displayed:

Figure 2: MonitorWare Console main dialog – showing trial period is over

As you can see that the "OK" button is disabled i.e. you can't enter the MonitorWare
Console application. If you press the License Option a dialog similar to the one shown
in figure 2 will open up.

Now if you selecet any module from the list (displayed in the bottom of the form) and
press "Request Trial" a dialog is displayed that says: "You can only request trials for
other modules if your base product is in trial or is licensed."

So, This will call for a license key for the Base Product. Assume that you had bought
the product key and entered the key. If you now press the request trial button after
entering the license key for the base product, it will not switch the desired module to
trial version. A dialog similar is displayed that says: "You cannot request trial for this
module for another 30 days".

This is because the user will get at most a 30 day trial period followed by a 30 day
disabled period. In the above quoted example your MonitorWare Console application
worked through the month of January. In February the application expired. Now if you
press the request trial button during March for a specified module, it will switch to the
trial version.

Note: The user can press the "Request Trial" Button, maximum 4 times i.e. 30
day trial period followed by a 30 day disabled period and so on. After 4 times
the MonitorWare Console  will not go into the trial version anymore.
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If the "Request Trial" is pressed for the Fifth time, a dialog appears that says: "You
cannot request trial for this module any more".

Note: Please bear in mind that you can't "Request Trial" for the base product.

The fields used in this form are described below:

Module Name for License
This option allows you to choose the module which you are interested in. A drop down
list displays the following options:

1.) Base Product
2.) Device Module
3.) Knowledge Base Module
4.) Windows Reporting Module
5.) Pix Reporting Module
6.) Views Module
7.) Network Scanning Tools

License Name

The option allows you to enter the license name for each individual module.

License Key

This option allows you to enter the license key for each individual module.

Clear

This option will clear all the enteries made in license name and key.

Update

Allows you to make updation to old entries.

Note: Please select the name of the module that you are updating from the list
displayed as in figure 1 and not from the drop down list of Module Name for License.

Request Trial

This option will allow you to request a trial version for the desired module.
Note: Please select the name of the module that you are requesting trial for from the
drop down list of Module Name for License and displayed as a list in figure 1.

Cancel

Closes the form.



42 MonitorWare Console

© 2006 Adiscon GmbH

3.1.2.8 EventID.NET License Options

EventID.NET is a web ressource that helps you with troubleshooting events. If you
have an account there, you can enter it here. By doing so, the account information
will be used whenever you access an eventid.net link.  Please note that eventid.net is
a third-party ressource with which Adiscon is not affiliated. We provide support for it
as a convenience.

You can access this by clicking on Options -> EventID.net License Options. Once
clicked, the following dialog box will be displayed:

Figure 1: License Form for EventId.net

In this form, you can enter the License Name and the key given by EventID.net. Even
if you don't enter the License Name and Key, you still will be able to search for event
ids (on EventID.net site) that are displayed in the reports. However, with the license,
you get some additional benefits. Please see the eventid.net site to see the actual
benefits.

The fields used in this form are described below:

License Name: License Name given by EventID.net

License Key: License Key given by EventID.net

OK: Saves the settings and closes the form

Cancel: Closes the form without saving the information

3.2 Modules

3.2.1 Base Product

Base Product is the core of MonitorWare Console. You cannot use MonitorWare
Console without the Base Product. So lets say that you are interested only in
"Windows Reporting Module", then you would have to purchase 2 licenses. One for the
"Base Product" and the other one will be for "Windows Reporting Module". Base
Product gives you following functionality:
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1.) ICMP Lookup Tool
2.) Database Maintences Tools
3.) Exporting and Importing Database Settings Tool
4.) Managing Users Tool (see Manage Users)
5.) Time Zone handling tool (see Time Zones)

3.2.1.1 ICMP Lookup Tools

ICMP Lookup is a feature that helps to get information on the basis of ICMP type and
ICMP sub type.

To access this tool, go to the tools menu in the main menu bar, select ICMP Lookup
sub menu. It will show you a dialog box similar to the one shown below:

Figure 1: ICMP Look up form

The fields used in this form are described below:

ICMP Type

This option allows you to enter ICMP Type number e.g. 3

ICMP Sub Type

This option allows you to enter ICMP Sub Type number e.g. 2

Look up

After pressing the Look Up button, it will take you to Adiscon's Repository (a web
page will be opened), where a description of the desired ICMP code would be
displayed.

Clear

It will clear the form.
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Cancel

It will take you out of the ICMP Look up form.

3.2.1.2 Export / Import Database Settings Tool

MonitorWare Console settings are saved in the database to which it is connected,
instead of saving it to the registry files. With this tool you have the flexibility to
import or export the database settings to which MonitorWare Console is connected.
This is specifically helpful during support routine as this enables us to create the exact
scenario in our test lab.

To access this tool, go to File -> Export/Import. Once this has been done, the
following dialog box will appear:

Figure 1: Export / Import Databse settings Tool

The fields used in this form are described below:

As you can see from the dialog box, this dialog has been divided into three parts.
Here is a brush-up detail.

The first part of the form allows you to choose the operation that you are interested in
precisely. Each one is defined separatley below:

Export Database Settings

This option allows you to export settings of the selected tables to an xml file.
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Import Database Settings

This option allows you to import settings of the selected tables from the selected XML
file.
The second part of the form provides a list of tables that can be exported. Each of the
options are defined below:

Reports Related

This option enables you to export reports related tables only.

Job Manager Related

This option enables you to export job manager related tables only.

User Preferences Related

This option enables you to export user preferences related tables only.

User Info Related

This option enables you to export user info related tables only.

Note: When you press Export button for this table, the user information, i.e the user's
defined login and password, is also exported. A dialog box will appear as shown
below:

Figure 2: Database Settings Import/Export Form

Web Search Related

This option enables you to export web search related tables only.
The third part of the form allows you to manipulate file options. Each is defined as
below:

FileName

This option allows you to specify the name of the file that is to be exported.
Note: This field would only be available if the user wants to export the tables, he is
interested in.
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File Path

This option allows you to specify the name of the file that is to be exported.
Note: If the user is exporting then this field will point to the path of that file. If the
user is importing then this field will contain the file name and its path.

Browse

When this button is pressed, a dialog appears which allows the user to select the
desired path on which the xml file is residing.

The Fourth part of the form allows you to manipulate the form as a whole. Each is
defined as below:

Export / Import

When this button is pressed then either it exports or imports the settings, depending
upon the selection that the user have made.
Note: If the Export Database Settings is checked then this button will appear as
Export. If the Import Database Settings is checked then this button will appear as
Import.

Cancel

When this button is pressed, it takes you out of the export/import database settings
form.

3.2.1.3 Database Maintenance Tools

3.2.1.3.1  Delete Records Tool

The underlying database to which the MonitorWare Console is connected can grow
very rapidly depending on the incoming traffic. If you want to delete the old records
for more disk space then this tool will provide you the flexibility to delete the records
or to take the backup and then delete the records from the database to which
MonitorWare Console is connected.

To access this tool, go to the tools menu in the main menu bar, and select Database
Maintenance Tools, then select Delete Records from sub menu. Once this has been
done, the following dialog box will appear:
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Figure 1: Delete Tool Form

The fields used in this form are described below:

Delete records older than 'x' days

This option allows you to delete the records older than 'x' number of days where x is
user defined.

On the basis of

This option allows you to take backup on the basis of DeviceReportedTime and
ReceivedAt Time (these fields are defined in the SystemEvents Table).

Note: DeviceReportedTime and ReceivedAt Time are different from each
other.

The DeviceReportedTime is actually the time that is there in the Windows
Event Log i.e. the time at which the (e.g. syslog) message was written into
the Windows Event Log.

ReceivedAt time on the other hand is the time when the (e.g. syslog)
message is received at the configuration program e.g. MonitorWare Agent.

Delete All Records

If you check this option than all the records are deleted from the database to which
the MonitorWare Console is connected.
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Figure 2: Delete Tool Form - Delete all records

Note: If you press the "Backup deleted items in a text file" over here then it will take
the backup of all the records and then these records are deleted from the underlying
database to which MonitorWare Console is connected.

Delete

When you press this button a message box will appear that will give you a warning
that this will delete all the records permanently. If you press yes to it, the records
would be deleted permanently.

Backup deleted items in a text file

As you can see from the "Deletion Tool Form" in figure 2, the File Name, File Path and
Browse Button are grey-scaled. This scenario occurs if you have not checked "Backup
deleted items in a text file" option. Once you have checked the "Backup deleted items
in a text file" option these options become valid as shown below:
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Figure 3: Delete Tool Form - Backup Deleted item in a text file

If this option is checked then it also takes the backup of deleted (which are to be
deleted) records in the specified path.

File Name

This option allows you to define the name of the file in which the backup of the
deleted records would be taken.

File Path

This option allows you to define the path of the file where the backup of the deleted
records would be taken.

Browse

When this button is pressed, a dialog appears as shown in the figure 4. This allows
the user to select the desired path on which the backup file will be saved.
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Figure 4: Browse - Select Folder Form

Delete + Backup

When this button is pressed then the records that are defined in the specifed range
are deleted from the database to which MonitorWare Console is connected but the
backup is taken before hand.

Cancel Backup

By pressing this button, the "Deletion Tool" form is closed.

3.2.1.3.2  Backup Records Tool

With this tool you have the flexibility to take the backup of the records from the
database to which MonitorWare Console is connected.

To access this tool, go to the tools menu in the main menu bar and select Database
Maintenance Tools, then select Backup Records from sub menu. Once this has been
done, the following dialog box will appear:
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Figure 1: Backup Tool Form

The fields used in this form are described below:

Backup records older than 'x' days

This option allows you to take the backup of the records older than 'x' number of days
where x is user defined.

On the basis of

This option allows you to take backup on the basis of DeviceReportedTime and
ReceivedAt Time (these fields are defined in the SystemEvents Table).

Note: DeviceReportedTime and ReceivedAt Time are different from each other.

The DeviceReportedTime is actually the time that is there in the Windows
Event Log i.e. the time at which the (e.g. syslog) message was written into
the Windows Event Log.

ReceivedAt time on the other hand is the time when the (e.g. Syslog)
message is received at the configuration program e.g. MonitorWare Agent.

File Name

This option allows you to define the name of the file in which to backup the data.

File Path

This option allows you to define the path of the file where the backup will be taken.

Browse
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When this button is pressed, a dialog appears which allows the user to select the
desired path on which the backup file would be saved.

Cancel Backup

When this button is pressed, the backup procedure is cancelled.

Backup

When this button is pressed, the backup procedure is initiated.

After Filling the required information and pressing the Backup button, the backup
process will start and inform you how many percent of the backup is done yet.

Note: The backup file saved on the desired location is saved in an XML
format. The Backup file Name has the format similar to the one in the
example e.g. Backup2004-2-16.xml (i.e. File Name + Date appended). If you
keep on taking backup frequently, this file format will help you to distinguish
between the files generated during the backup procedure.

3.2.1.3.3  Retrieve Records Tool

With this tool you have the flexibility to retrieve the records into the database to
which MonitorWare Console is connected.

To access this tool, go to the tools menu in the main menu bar, and select Database
Maintenance Tools, then select Retrieve Records from sub menu. Once this has been
done, the following dialog box will appear:

Figure 1: Retrieval Tool Form

The fields used in this form are described below:

File Path

This option allows you to enter the path of the file that will be used for retrieving the
records.

Browse
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When this button is pressed, a dialog appears which is user configurable. This dialog
allows the user to select the desired path on which the backup file resides i.e. to be
used for record retrieval purpose.

Cancel Retrieve

When this button is pressed, the records retrieval process is cancelled.

Retrieve

When this button is pressed, the records retrieval process is initiated.

Note: If you haven't deleted the records after taking the backup and you retrieve the
backup file; then records are retrieved into the database to which MonitorWare
Console is connected. In this case there would be a duplication of records. But if the
records have been deleted and then retrieved then there would be no duplication of
records.

3.2.1.3.4  Create / Remove Indexes Tool

Create / Remove Indexes Tool

This tool will manage Indexing of the database table. In fact it will it will
create/remove Index on ID column and FromHost column of SystemEvents table. In
short, Index will help to improve performance querying records from the database.
For further information we recommend to take a look at "Concept of Indexing":

Figure1: Choose...

Decide if the indexes should be create or remove. Click "Next" button to
proceed.
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Figure2: Indexes created successfully

If you chose "Create Indexes" in the initial step, you will see Figure2 if the
indexes were successfully created.

Figure3: Indexes removed successfully

If you chose "Remove Indexes" in the initial step, you will see Figure2 if the
indexes were successfully created.

3.2.2 The Views Module

Views module (Raw Log Analysis) is one of the most powerful features of MonitorWare
Console. Using this module, you can define your own views according to your needs.
This module also supports the concept of "Drill Down". You can define various levels
of field hierarchies in view definition. As you proceed towards the lower levels of
hierarchies, the data is filtered using the above hierarchy levels. In addition to that,
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you can also apply some other filters on the data, which include: Time based filters,
Device based filters and Info Unit based filters. The details are given in the coming
sections.

For views, you can define some global settings. The global settings are picked up by
each view when you create it. Ofcourse, you can overwrite these values for each
individual view but it definitely saves a lot of time if you want to create many new
views with almost same settings. First of all, we will discuss these "Global Settings"
and then we will move on to the "View Manager"

Note: For better results, it is highly recommended that "Legacy Format" is
not selected in "Event Log Monitor" service in EventReporter or MonitorWare
Agent.

3.2.2.1 View Manager

View Manager can be opened in one of the following ways:

1.) Click on the "Views" button in the main Tool Bar.
2.) Click on "Modules" in the main Menu Bar and click on "Views".
3.) Click the "Events View" Node in the tree view.

Once the View Manager is opened, you will see the following screen:

Figure 1: Event View Manager

If you already have made some views earlier, the list view on the right side will show
you those views. They will also be present in the form of Nodes under the Events View
Node.
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3.2.2.1.1  Creating a New View

A new view can be created in one of the following ways:

1.) Click the "New" button in the View Manager Tool Bar.
2.) Right click on the list view on the right side of the screen in the above

figure and click on new.
3.) Right click on Events View node and click on New.

Once you have done this, the same screen as shown in figure 1 will open up but with
an additional tab of Field Hierarchy as shown below:

Figure 1: Field Hierarchy Tab

As you can see from the above figure that apart from the Field Hierarchy tab, all of
the other tabs are the same as explained in the Common View Settings except for the
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General tab which now contains some additional information that you need to enter as
shown below:

Figure 2: General tab containing additional fields

In this tab, the above group box is the same as that in the common view settings.
There is a new group box at the bottom, which is specific for each view. In this group
box, you can enter the title, description and file name of the view. Note that File
Name is a must in this case. If you don't specify a file name, view cannot be saved.
Title and Description are optional but it is always a good idea to enter some
descriptive sentence so that later on you can identify the functionality of this view.

When a new view is opened for creation, the first five tabs will show the settings that
you saved in the Common View Settings (global Filters). You can override these
settings by defining new settings for the view that you are currently creating.

The Field Hierarchy tab allows you to define Levels of Hierarchies that you want to see
in the Tree view. Double clicking on any of the fields from the above list will bring that
field in the lower list as the level 1 field. You can also add a field to Selected Fields list
by clicking on the "Add" button after selecting that field from the above list. If you
add another field to the Selected Fields list box, it will be added as the level 2 field
and so on. After adding a field to Selected Fields list box, if you want to change the
level of a specific field, simply select that field and use the up or down arrow on the
right side to increment or decrement its field level respectively.

In order to change the maximum nodes or the sort order associated with a specific
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field level, double click that field in the selected fields list view. A dialog box will open
up where you can enter this information. You can sort based on four different things:

1.) Ascending on field values
2.) Descending on field values
3.) Ascending on volume
4.) Descending on volume

The ascending and descending on volume can be used when you are interested to see
the events that have occurred very seldom or very frequent respectively.

3.2.2.1.2  Editing a View

To edit a view, you can use one of the following ways:

1.) Select a view and press the Edit button in the View Manager's Tool bar.
2.) Right click on any view in the View Manager's List view and click on edit.
3.) Right click on any view in the tree view and click on edit.
4.) While the view is open, you can also edit it by pressing the edit button on

that view form. Any changes that you will make while looking at the view
will be reflected as soon as you close the edit dialog box.

Once you select any method mentioned above, the same screen as that shown in the
new view is opened but this time all the fields will show the settings that were saved
with this view when it was created. You can change any of the values and press finish.
This will update the view.

3.2.2.1.3  Refreshing the list of views

To refresh the list of views, you can use any of the following methods:

1.) Press the Refresh button in the View Manager's Tool bar.
2.) Right click on the list view of View Manager and click on Refresh.
3.) Right click on the Events View node and click on Refresh.

Once any of the above-mentioned ways has been selected, the list of views in the
Tree view as well as in the list view would be updated from the views folder.

3.2.2.1.4  Deleting Selected Views / Deleting All Views

Deleting Selected Views

A view can be deleted in one of the following way:

1.) Select view(s) and press Delete button in View Manager's Tool bar.
2.) Right click on a view in the list view and press delete.
3.) Right click on a view in the tree view and press delete.

After pressing delete the selected views will be permanently deleted and you will not
be able to access them again.
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Deleting All Views

In order to delete all the views permanently, use one of the following ways:

1.) Press the Delete All button in the View Manager's Tool Bar.
2.) Right click on the Events View node in the Tree View and click on Delete

All.

After 1 or 2, all the views will be permanently deleted and you will not be able to
access them again.

3.2.2.1.5  Opening a View

A view can be opened in one of the following ways:

1.) Select a view and press the Open Button in the View Manager's Tool Bar.
2.) Double click on any view in the List View of View Manager.
3.) Click on any view node in the Tree View.

Once a view is opened, you will see the following screen:

Figure 1: Opened View

The above figure shows you an opened view. The right side of the figure is a data
grid, which will display you the records according to the query that was constructed
according to the filters that you applied while creating this view. The columns
displayed are those that you selected while creating a view. They are also displayed in
the order in which you have placed them while creating the view. The header text is
the text that you assigned as the display name.

When you open up a view, it will display the columns with default width values. If you
want to change the column width, simply drag the column and make the width
according to your choice. This width would now be saved permanently for you so that
even if you close the application and open it once again on the next day, you will see
the new widths of the column so that you don't have to adjust them every time.

When a view is opened, there are two aspects that need to be explained: First is the
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Event View form and second is the Tree View itself. The following sections will explain
both.

3.2.2.1.5.1  Event View Form

On the right hand side, you will see this Event View Form.

Figure 1: Event View Form

Editing a View

When the edit button is pressed, form shown in "Editing a View" would pop up. You
can make any changes that you want and then pressing the finish button on that form
will reflect all the new changes in this currently open view.

Saving the Records

Select the records that you want to save and click on the "Save As" button in the
Event View Form's tool bar. A popup will open up, which lets you choose the path and
file name where it should save the records as a CSV file (Comma Seperated Values).

Refresh

Simply refreshes the records.

Auto Refresh

This feature will refresh the view automatically from the database after specified
interval of time. When this button is pressed, a dialog box similar to the one shown
below will open up.

Figure 2: Auto Refresh Form
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Check the check box in the above figure if you want to have the auto refresh feature.
When the checkbox is checked, you can also specify the number of seconds after
which your view would be refreshed.

One thing that must be kept in mind regarding the Auto Refresh feature is that if you
have set a very large value of the page size and a very small time interval after which
the page should refresh, then the performance of the Auto Refresh feature might not
be good. The reason is that the previous records will not be brought yet from the
database when the time for the next refresh comes and then it goes back to the
database to fetch the fresh records once again.

We strongly recommend using small page values for the view for which you intend to
use Auto Refresh feature so that the above mentioned problem is not encountered.

Select All

Selects all the rows that are present in the data grid.

Row View

If you want to see the details of any row, simply select that row and press the "Row
View" button in the Event View's tool bar. The second option is that you double click
on that row whose details are required. Another form will open up which will show you
the details of that event. For details about this form, please read Row View Form.

Generate Report

Views Module is one of the most powerful modules of MonitorWare Console and you
can use it to create very powerful views exactly according to your requirements. If
you click on this button "Generate Report", it will generate an HTML based report for
the current view. With this approach, you can generate the reports that suit your
requirements. This feature gives you a great power in defining your customized
reports.

Previous

Pressing the Previous Button will take you to the previous page of this view.

Next

If the number of records is more than the Page Size that you specified for this view,
then pressing the Next button will take you to the next page.

Changing the Sort Order

You can also change the sort order of an open view. Simply use the "Change sort
order to" combo box to change the sort order of the currently displayed view. As
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mentioned above, this sort order is based on the ID.

3.2.2.1.5.2  Row View Form

Clicking on the "Row View" button will open up a form similar to this one.

Figure 1: Row View Form

New KB Article

You can create a new KB (Knowledge Base) Article associated with this event view
row by pressing the "New KB Article" Button. Refer to Devices module for more
details.

Search KB Article

You can search the Knowledge base for the articles associated with this Event Row
View. Refer to Devices module for more details.

Web Search

You can search the net for some articles for this event view row. When you press the
down arrow on this button, you would see that there are some searches already
defined. Lets say you select "Google search on Event ID", then it will open up a
browser and will search for Event ID = x, where x is the Event ID that is currently
displayed on the Row View Form. If you would like to define your own query strings,
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you can click on Web Search Button down arrow and select "Web Search Urls" or
alternatively, you can open it up from the Options button of the main tool bar and
then selecting "Web Search Urls". After selecting any of the above mentioned ways,
you will see the following dialog box:

Figure 2: Web Search URLs

The Url is the actual url value that you want to send to the browser. Note that the $
signs will be replaced by the values from the event row view form (the form from
where you will initiate this search).

If you want to insert a new url, make sure that the base string
(http://www.google.com/search?q=) stays the same. You then have an option of
selecting from the list that is displayed on the right side. Simply double click on any
value and it will be added to your url string. Once done, press the "Insert" button and
it will add a new search url string at the top most list. For details about Web Search
URL form, please read Web Search URLs.

Additional Info

This button would normally be disabled, however if the message field contains some
information regarding ICMP, then this button would be enabled. Clicking on this
button would pop up another dialog box in which some additional details regarding
the message can be seen.
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3.2.2.1.5.3  Tree View

Figure 1: Tree View

When you click on any view, it will display you all the distinct level 1 fields values
(along with their counts). If the number of nodes brought by the query for this first
level is greater than the maximum nodes that you defined for this first level field
while creating the view, then a new node "See More" will be created in blue color.
Clicking on this node will bring the remaining nodes.

Note that it will bring the nodes in chunks of Max Nodes that you defined for
this field.

Once you click on any level 1 field, a red light as shown in figure 1 will be displayed
along with that node meaning that user has expanded this node. Now if you had
defined any level 2 field in the field hierarchy of this view, then all the distinct values
of that field would be displayed under the clicked node. Secondly, the Data grid on
the right side would also be updated according to new query.

3.2.3 The Devices Module

A Device refers to any piece of hardware or gadget that is hooked up to the network
and reports or logs events/messages using some well-defined mechanisms like Syslog
or Windows Event log etc. MonitorWare Console provides an easy and user-friendly
way to track all such reporting devices in the system.

The Devices module allows users to add, update, delete or discover device(s). Apart
from these features, user can associate a knowledge base article with specific
device/devices, which can later help in troubleshooting or tracking device specific
issues and information.
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3.2.3.1 Device Manager

Device manager can be opened using one of the following ways:

1.) Click on the Devices button in the main tool bar.
2.) Click the Managers Menu in the menu bar and then click on Device
Manager.
3.) Click the Devices node in the tree view.

After the user has selected one of the above-mentioned ways, then a form similar to
the one shown in the next figure would be displayed:

Figure 1: Device Manager

Device Manager displays a list of all the registered devices in the list view. On top of
the Device Manager, there is a toolbar having new, edit, refresh, delete, delete all,
discover and close button.  Details of all of the Device Manager's features are given in
the coming sub-sections.

Refreshing Device Manager

If new devices have been added by other users, or device details have been changed,
you will not notice this immediately. You need to refresh device manager to see these
changes. To refresh, do either of these:

1.) Press F5 key on the keyboard.
2.) Press Refresh button on Device Manager's tool bar.
3.) Right click on the list view and select refresh.
4.) Right click on the Device Node in the tree view and click on refresh.

Once the user has selected one of the above-mentioned ways, the device manager
would be refreshed from the database and will display fresh entries.
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3.2.3.2 Creating a new Device

The form for creating a new device can be displayed in one of the following ways.

1.) Click on the new button in Device Manager's tool bar.
2.) Right click on the Device Manager's list view and click on New sub menu

item.
3.) Right click on Devices Node in the tree view and click on add.

After the user has selected one of the above-mentioned ways, a form similar to the
one shown in the next figure is displayed:

Figure 1: Device Information Form

Device Reported Name is the name of the device and Device Assigned Name is some
useful name that can also be associated with this device. Rest of the fields on this
form are self-explanatory.

The tool bar in this form contains New KB (Knowledge Base) Article, Save, Clear,
Search KB and Close button. A brief description of all of them is given below.

New KB Article

If the user clicks on this button, a form, as shown in figure 2 is displayed. This form
will now be used to create a Knowledge Base (KB) article that is related to this device.

Note: that the same KB article can also be related with other devices as well.



67Using MonitorWare Console

© 2006 Adiscon GmbH

Figure 2: New KB Article

For information about this form, refer to "Editing a Knowledge Base Article" sub
section in "Knowledge Base Module".

Save

This button will save the information that the user has entered in the form.

Clear

This button is used to clear all the fields that are there on the form.

Search KB

This button will open up the Knowledge Base Manager that will display all the articles
that are associated with this device.

Close

This button will simply close the form.
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3.2.3.3 Discovering Devices

Form for discovering devices can be opened in one of the following ways:

1.) Click on the Discover Devices button in Device Manager's tool bar
2.) Right click on Device Manager's list view and select Discover.

Once the user has selected one of the above-mentioned ways, a form similar to the
one shown below, would be opened:

Figure 1: Discover Devices Form

This form displays a list of all of the devices that are yet to be discovered.

Save All

This button will discover all the devices and after this action, all the devices that were
initially there in the list view of Discover Devices form will now be shifted to the
Device Manager's list view. In other words, they have been discovered.

Save Selected

This button will discover only those devices that have been selected from the list view
in the Discover Devices form.

Refresh

Simply refreshes this list from the database. If a new device has logged some data in
the database after this form was opened, then pressing the refresh button would also
bring that device in the list view of figure 1.

Close

Closes the form shown in figure 1.
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3.2.3.4 Editing a Device

Form for editing a device can be opened up in one of the following ways:

1.) Select the device that you want to edit and press the edit button in Device
Manager's tool bar. If more than one device has been selected, then the
last selected device would be opened for editing.

2.) Right click on any device in the list view of Device Manager and click on
edit.

3.) Select a device from the list view and press enter key on the keyboard.

After the user has selected one of the above-mentioned ways, a form will open up and
all of the fields would have the values that are associated with this opened device. If
any of the value is changed and the save button is pressed, the opened device is
modified to the fresh entries. Note that a new device would not be created in this
way. For creating a new device, refer to "Creating a new device" sub section of this
module.

3.2.3.5 Deleting Devices

Deleting one or some Devices

Device or Devices could be deleted in one of the following ways.

1.) Select Device(s) to be deleted and press the DEL key on the keyboard.
2.) Select Device(s) to be deleted and press the Delete button in Device

Manager's tool bar.
3.) Select Device(s) to be deleted and right click on the selection. Select

Delete.
4.) Select a specific device from the tree view. Right click on it and press

delete.

Once the user has selected one of the above-mentioned ways, then the device would
be deleted from the device list.

Note: You can discover this deleted device once again using the Discover device
button that is explained in the coming sub sections.

Deleting all Devices

All of the devices can be deleted in one of the following ways:

1.) Press the Delete All button in Device Manager's tool bar
2.) Right click on the list view and click Delete All
3.) Right click on Devices node in the tree view and click Delete All

After the user has selected one of the above-mentioned ways, all the devices would
be deleted but you can discover them later using the Discover Devices button, which
is explained in the "Discovering Devices".
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3.2.3.6 Running Tools on Selected Device

As mentioned in the section of tools, there are three network tools in MonitorWare
Console.

1.) Ping Tool
2.) TraceRoute Tool
3.) PortScan Tool

You can right click on any device that is displayed in the tree view and select the
network tool that you want to run on that device.

Note: You will only be able to run these tools if you have a valid license for
"Network Scanning Tools"

3.2.4 The Reporting Module

Adiscon MonitorWare Console offers flexible and extendible reporting features. There
are two Reporting Modules available for purchase. Windows Reporting Module and Pix
Reporting Module. Additional a so called Bonus Reports is available if you bought one
of the two Reporting Modules. Bonus Reports are free of charge.

In addition to several useful reporting templates provided with the application, users
can order new reports exactly according to their own requirements and these new
reports will be incorporated in MonitorWare Console application seamlessly.

The Reporting Engine of MonitorWare Console has been designed in such a way that
the reports can act as Plug and Play components. If you feel that you need a report
that is not present in MonitorWare Console, you can ask us at support@adiscon.com
and we will look into what it takes to generate the report. We will then let you know if
there is any cost associated for creating this report.

Once you give us a go, we create the new report exactly according to your
requirements and will send you the plug in component. All that you have to do is to
put the component in the proper place (which we will let you know when we ship the
component to you) and it will become fully integrated with MonitorWare Console. Of
course you do not have to install MonitorWare Console again.

Any reports generated by Adiscon will become part of the standard product. As such,
you can be sure that your report will always be adjusted to new product versions -
without any cost at all!

In the next chapter, we will discuss the things which are general and common to all
Reporting Modules. Then we will proceed to the specifics of the modules and also will
explain the Job Manager which is used for scheduling reports.
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3.2.4.1 PIX Reporting Module

All of the reports that are shown in Blue colour are PIX Reports.

PIX Reports

Following are the PIX Reports that are present in this release.
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Report Name Report Description

Accessed Web Sites Report This report shows
most Accessed
Websites sorted by
webserver and by
source.

Blocked Ports Activity Report This report tells you
about the activity
that is going on your
blocked ports and
also tells the ip
address from where
this activity is
initiating.

Possible Attacks Report It displays various
attacks that have
been attempted on
your network, their
explanation and what
should be done to
avoid them.

PIX Summary By Message Type It displays summary
of different messages
by their type and
count.

Traffic By Hour Report It displays the total
internet traffic for
your network for
each hour of the
specified day.

Traffic By Port Report It displays the break
down of total
internet traffic for
your network for
each hour of the
specified day.

Outbound Traffic By IP It displays the break
down of total
internet traffic for
each computer of
your network.

Traffic By Target IP It displays the break
down of total
internet traffic for
each site accessed
from your network.

PIX report by Severity Level It displays the
summary of PIX
messages by severity
level

For detailed information on these reports, please visit
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http://www.mwconsole.com/en/Product/pix-reports.asp

3.2.4.2 Windows Reporting Module

All of the reports that are shown in Purple colour are Windows Reports.

Windows Reports

Following are the Windows Reports that are present in this release.

Report Name Report Description

System Status Report It displays data in
the form of
hierarchies useful for
Administrators.

Needle in Haystack Report Displays the least
occurring events first
and most occurring
events last along
with their counts.

Last Log On Report This report gives you
the last occurances
of the Log ons by
various users.

Log On Log Off Report This report gives you
the sequence of Log
on and/or Log Offs
for specified inputs.

User Activities Report Show and explain the
activity of users.

For detailed information on these reports, please visit
http://www.mwconsole.com/en/Product/reports.asp

3.2.4.3 Report Manager

You can open up Report Manager by:

1.) Clicking on "Reports" button in the main tool bar.
2.) Clicking on Modules -> Reports from the menu bar.
3.) Clicking on "Reports" node in the tree view on the left.

After you have followed any of the above mentioned steps, you will see something
similar to the following figure:

http://www.mwconsole.com/en/Product/pix-reports.asp
http://www.mwconsole.com/en/Product/reports.asp


74 MonitorWare Console

© 2006 Adiscon GmbH

Figure 1: Report Manager

Before we proceed, its important to give 2 definitions here that will be
frequently used throughout the Reporting Module.

Report Template

A Report Template is the report that is shipped with MonitorWare Console. All of the
reports are Report Templates. You can create as many "Saved Reports" as you like
from these "Report Templates" by applying different filters or adjust the reporting
format for example. You can not generate a report from a Report Template itself. You
have in any case first create a "Saved Report".

Saved Report

Saved Reports are the reports which you can save by opening up a specific template.
For each report you can specifiy different settings that will apply to only that Saved
Report. For example, in the above figure, there are 3 "Saved Reports", which the user
has saved himself for the Report Template "Traffic By Target IP". Each Saved Report
can have its own name, own description, own settings and own filters. In the above
sample, the first saved report i.e. "last 24 hours report" has been saved by applying
the filter so that the "Traffic by Target IP" is displayed for the last 24 hours only.

Report Manager (RM) provides a centralized control over all Reporting related
functions. In Figure 1 RM is the screen visible on the right hand side – visually it is
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identified with title in a lilac band on the top of the screen. Report Manager provides
following functions:

1.) RM displays the list of all templates and saved custom reports. In the
Report Manager, you will see some reports in Blue color and some in
Purple color. The reports in Blue color are PIX reports. The reports in the
Purple color are the Windows Reports. The ones in the lighter shade are
their corresponding Saved Reports that the user has saved after applying
some filters on that report.

2.) RM is synchronized with the Tree control present on the left hand side of
the main window. The same templates and saved custom reports are
shown hierarchically in the tree control as well. Saved custom reports are
shown as sub nodes to the corresponding templates. In the above figure,
a plus (+) sign with System Summary template in the tree control tells
that there are saved custom reports available for this template.

Refresh

This button in the RM toolbar fetches the fresh list of reports.

Delete

Deletes the selected template and its corresponding saved reports as well. Note that,
templates (being .dll files) are not physically deleted from the folder, they only get
un-registered from the application. To register them again, simply click on "Refresh".

Delete All

Deletes all of the reports and their corresponding saved reports.
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3.2.4.3.1  Opening a Report

If you double click on any report, it will open up the following form

Figure 1: Report Options

This form displays the report options. If you double clicked on any "Template", then in
that case, this form will open up. On the other hand, if you double clicked on any
"Saved Report", then this form will open up and will display you the settings that you
had saved.

Advanced Filters

In some of the reports, you will find this Advanced Filter Button on the Filter Form.
These filters are required specifically by the current report and don't have any thing to
do with the underlying database. For example for the System Status Report, clicking
on "Advanced Filters" button will open up a form similar to the one shown below:
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Figure 2: Advanced Filter Form for System Status Report

Generate Report

This button will generate the report according to the settings that you have made in
this form. Note: Generate Report button is only available if a "Saved Report" was
selected. Generate reports from a "Report Tempalte" is not possible. Furhter, if you
haven't selected a data source for this report, then the button will be gray and not
clickable. This means that you have to complete your settings and save them first. If
you just changed some settings and want to generate a report, you will be
automatically told that the settings have changed. Respective you have to save the
report first in order to generate a report with the new settings.

Save

Initially you can only see so called template reports. To run a report you have to
configure and save it. Then it is called a "Saved Tempalte" (or sometimes also refered
as "Custom Report"). Saved Report include information about the data sources which

should be used, filter options and so on. Clicking "Save" displays the following form:
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Figure 2: Saving Custom Reports

Users must enter a "Report Title" and optionally, some short description for later
reference. This information is later displayed in the Report Manager form for quickly
finding the desired report.

Important point to note is that you can modify a Saved Report and save it under an
other name. So you can quickly configure similar Saved Reports which minor
configuration changes. E.g. just change the time filter.

Save and Close

This button saves the custom report like above, but it closes the properties windows
right after that and returns you to the Report Manager interface.

Close

Simply closes this form.

In the following chapters, the three tabs on this form will be explained.
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3.2.4.3.1.1  General Tab

Figure !: General Tab

HTML Report Related Options

The HTML Report Format was already used in previous versions of MonitorWare
Console. It creates a HTML based report with all the info that is extracted from your
log files or log database according to the filters you set. This old-fashioned method is
still well suited to create reports which are viewable on nearly any basic setup of
actual operating systems by default.

Use legacy HTML Report Format

If selected Reports are generated in HTML format. This was the only format available
in previous versions of MonitorWare Console.

Pick images from

This option allows you to pick images from web or from the local disk

Select Template for Generated Report

You can select various templates for the HTML reports that will be generated. Test
them if you want and choose which one suits you the best.
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Open report after creation

If activated, the report will open up after it has been successfully created.

Crystal Report related Options

The Crystal Reports give your reports some new paint. The Crystal Reports engine is
capable of creating Reports in different formats. Now it's up to you which you like.
You can either choose HTML reports for embedding in your intranet website, PDF for
e-mail attachments or excel sheets. Simply choose the format you require.

Use Crystal Report Format (more flexible and more options)

If selected Reports are generated by using Crystal Report engine. Crystal Report
format gives a great opportunity to get reports in the format you prefer.

Open in Report Viewer after creation

If checked after generation the report will be displayed in the Crystal Report Viewer.

Export Report into File after creation

If checked writes the report in the selected format to disk.

Open generated report after creation

Display the generated report after creation if checked.

3.2.4.3.1.2  Data Sources Tab

Here you can configure your data sources which you want to use for your report(s).
These data sources are necessary for creating reports, because they contain the
information you want to analyze. Therefor you need for every report at least one data
source. This doesn't mean that you need to have a database (or text file log) for every
single report, but that you need at least one data source configured for creating those
reports. you can use a data source for multiple reports or use multiple data sources
for one report. You can even configure multiple data sources from the same database
(e.g. configured to read out a different Table) in order to have only one database to
manage.
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Figure 1: Data Sources Tab

Available data source(s)

Here you can access a dropdown menu in which all added and configured data sources
like databases or text file logs can be selected.

Add

Click this button to add the selected data source form the "Available data source(s)"
box to the "Data source(s) in use" box. This function is for specifying which data
source(s) are used for this custom report you are currently configuring. It's up to you
if you want a single source to be included in the report or if you want multiple sources
to be included.

New / Data Source Wizard

A click will open the Data Source Setup Wizard. Here you can add and choose from
different kind of database structures like simple text file logs, access database or MS
SQL and MySQL databases.
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Figure 2: Data Source Wizard startup screen
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Figure 3: name and type of data source

In this screen of the wizard you can choose a screen name for your data source. Keep
in mind that it is always useful to choose meaningful names so that you don't get
confused if you have to change some options later and need to edit the settings for a
specific database. Second option you can configure here is what kind of data source
you want to use. You can choose between text files, MS SQL, MYSQL and Access
databases. Click "Next" to proceed or "Cancel" to discontinue the configuring process.
Depending on which type of data source you chose (database or text file) you will be
forwarded to Figure 4 (db) or Figure 5 (text file).
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Figure 4: Access informations for the chosen database type

If you chose a database as data source you will encounter this screen (Figure 4). Here
you have to insert the databases' DSN, and your login Information (assuming they are
set in your database). By default the settings for "Table" and "Property Table" are set
like above. Of course you can change these settings to access different data, too. Just
hit next again for the next step.
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Figure 5: Location information for text file

If you chose a text file as source for your reports, then you will see this screen. You
only have to enter the correct location of the file(s). Insert the correct path and
filename for that. If you have multiple log files in there, e.g. one file for each week or
day, then you can use wildcards as parameters to access these files. You can choose
from the following list:

* Zero or more characters
? Zero or exactly one character
%Y Year with 4 digits
%y Year with 2 digits
%m Month with two digits
%d Day of month with two digits

That way you can easily select multiple files with a different timestamp without
making a whole list or choosing a complete directory. For the time being wildcards are
restricted to those listed here. Filenames could look like this:

test-2006-10-23.log

A corresponding filename with wildcards could look like this:

test-2006-10-%d.log
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This one would be responsible for all logs that have a timestamp for octobre 2006 and
the appropriate prefix.

Figure 6: Chosing the data format to use

In Figure 6 you can now see a list of different data source format. Choose the one
corresponding to the device that created the logs you want to make a report of. Of
course you "could" use multiple format setups all at once, but this is not
recommended due to performance issues appearing when doing that. This screen is
also shown for the textfile data source. The data source formats listed here are the
only available at the moment. Keep in mind that db stands for database and text file
represents logs in a text file. You cannot make windows reports with a text file log.
More formats are yet to be implemented.
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Figure 7: summary of the setup

Before finishing the setup you get a summary of the setup you made. Here you get
once more all the information about the configuration you just created. You should
check it before finishing the setup. If you found an option set false you can use the
"back" button to go back and correct this. Keep in mind that you can do the settings
once more by pressing the edit button.
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Figure 8: Finishing the setup

Here you get a final result of your data source setup. Check the report if everything
went OK and then just click finish. Now you have created your first Data Source. You
can choose it now from the data sources dropdown menu and include it in your
custom report preferences.

Edit

This Button will open the Data Source Wizard again to reconfigure the setup of the
selected data source. There are two things different to the "create" wizard.
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Figure 9: Choose the Data Source

1. The first difference is, that the first step you have to take is to choose which of
your configured Data Sources you want to edit. For this you get this screen (Figure 8)
with a dropdown menu to choose from. When you have done this simply click "Next"
to proceed.
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Figure 10: change the Data Source type

2. The second difference is that you cannot edit the Name of your Data Source (Fig.
9). Here you can see that the name is grey, which means that this information field is
neither accessible nor editable.

Delete

The Delete button brings up the wizard that deletes the data sources which you don't
need anymore. For this you get a dropdown menu again (like in Fig.9) from which you
can choose the Data Source configuration you want to delete. Hit next to proceed.

Remove

Will remove the selected item from "Data source(s) in use". Just highlight the data
source in the list an click the button. This removes the Data Source from the list that
would else be used to create the report.

Data source(s) in use

Here all data sources used for this report are displayed.
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3.2.4.3.1.3  Filter Options Tab

Figure 1: Filter Options Tab

Note: Below, you can find the description of this filter form. However, if you are
interested in getting detailed help about using this filter form for applying filters, then
click on: http://www.monitorware.com/Common/en/Articles/guide-for-applying-
filters-mwconsole-21.php

Add Filter

When you click on this column, it displays you a list of all those columns on which you
can apply filters.

AND

When you press on this button, it adds an "AND" node on the left side in the tree
view. The columns that come under this node are ANDed together

OR

When you press on this button, it adds an "OR" node on the left side in the tree view.
The columns that come under this node are ORed together

NOT

http://www.monitorware.com/Common/en/Articles/guide-for-applying-filters-mwconsole-21.php
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When you press on this button, it adds a "NOT" node on the left side in the tree view.
The condition that come under this node are NOTed (i.e. if true, it becomes false and
vice versa)

Change Operator

If you click on this button after selecting some AND, OR or NOT node, it changes the
operator if possible.

Up Arrow

It simply moves the selected node one place above in the tree

Down Arrow

It moves the selected node one place down in the tree

Delete

It simply deletes the selected node and all its children

Select Operator

Several operators are provided for applying meaningful filters. These operators
generally correspond to the most common SQL operators that may be mentioned in
the WHERE clause. For additional information on the use of operators see
Operators' Reference.

Select Lower Value

In the "Select Lower Value" combo box, values corresponding to the selected field
(Select Column combo box) are picked from the database for user's convenience.

Note: Only top 100 values corresponding to each field are picked for this purpose.
However, users can enter their own values if required.

Select Upper Value

In the "Select Upper Value" combo box, values corresponding to the selected field
(Select Column combo box) are picked from the database for user's convenience.

Note: Only top 100 values corresponding to each field are picked for this purpose.
However, users can enter their own values if required.

Add
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This button is enabled only when "is one of" or "is not one of" operator is selected
from "Select Operator" Combo box. You can select different values from "Select Lower
Value" combo box and click this button to add to the list on its right. Please note that
the filter does not add, until you click on "Add Filter" button.

Remove

This button is enabled only when "is one of" or "is not one of" operator is selected
from "Select Operator" Combo box. You can select different values from the list on its
right and click this button to remove them from the list on its right. Please note that
the filter does not update, until you click on "Add Filter" button.

Set Value

If you click the "Set Value" button, after specifying the filter, adds that filter to be
applied to the report. All added filters are displayed in the text box on the filter form.
Any number of filters may be added.

Note: Some of the controls on the filter form are only enabled under special
conditions. For example, the date time picker controls are only enabled when
the selected field is of DateTime type. Controls in the section "Select Upper
Value" are only enabled if the selected operator requires a range of values
rather than a single value. For example, "is between" operator requires a
lower and an upper value to be defined for its proper working.
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3.2.4.3.1.4  Operator Reference

Figure 1: Select Operator

"Select Operator" combo box is used to apply an operator on the selected
field. "Select Operator" contains the following operators:

1. is any value:  This filter can be applied when no filter is to be applied on a field.
2. is equal to: This will bring only those records that match the criteria against "is

equal to" e.g. ID is equal to 4 will bring only those records where ID is equal to 4.
3. is not equal to:  This will bring only those records that  match the criteria

against "is not equal to" e.g. ID is not equal to 4 will bring all those records where
ID is not equal to 4.

4. is one of: When "is one of" is selected, user has to press the add button to add
the values to the list. If any of the values matches, the record is brought. e.g. ID
is one of 4, 5, 6 will bring all those records where ID is equal to 4 or ID is equal to
5 or ID is equal to 6.

5. is not one of: Same as above but the difference is that it will not bring those
records that have been added in the list.

6. is less than: This will bring all the records that are less than the specified value.
E.g., ID is less than 5 will bring all the records where ID value is less than 5 in the
database. Note: that it will not bring a record with ID value equals to 5. In other
words, the specified value is exclusive.

7. is less than equal to: Same as above but with the difference that it will bring
the specified value as well. E.g. ID is less than or equal to 5 will bring all those
records where ID is 5 or less. Note that in this case, the specified value is
inclusive.

8. is greater than: This will bring all the records that are greater than the specified
value. E.g., ID is greater than 5 will bring all the records where ID value is greater
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than 5 into the database. Note that it will not bring a record with ID value equals
to 5. In other words, the specified value is exclusive.

9. is greater than equal to: Same as above but with the difference that it will bring
the specified value as well. E.g., ID is greater than or equal to 5 will bring all
those records where ID is 5 or greater than 5. Note that in this case, the specified
value is inclusive.

10. is between: This will bring the records between the specified limits. E.g., ID is
between 5 and 7 will bring records where ID value is between 5 and 7. Note that
in this operator, upper and lower values are inclusive. In other words it will bring
records for ID equals to 5 and 7 as well if they exist in the database.

11. is not between: Same as above with the difference that it will bring all the
values that are not there in the specified range. This operator is inclusive too.

12.  is like & is not like: These operators are only visible in "Select Operator" combo
box if the user selects a column from "Select Column" combo box whose data type
in the database is Text. These operators work exactly like the SQL operators Like
and Not Like, respectively – note that the SQL version and dialect of the
underlying provider affects what syntax may be used for these operators. The
operators allow users to use wild cards in filters. Refer to the following table for
simple wild card characters that maybe used with Access and SQLServer
databases.

Consult the SQL documentation for a more detailed list of possible wild card options
and their usage:

Operation SQLServer Acce
ss

Match any string % *

Match any character _
(Underscore character)

?

3.2.4.4 Job Manager (JM)

Job Manager is a Windows Service that runs in the background and generates reports
according to user-defined schedules. It also has the capability of sending the
generated reports to specified recipients via email. The settings of this service are
done from the MonitorWare Console Client. This client will only be available to you if
you have a valid license for "Windows Reporting Module" or "PIX Reporting Module" or
both. Once you open up Job Manager Settings form as shown below, you will be able
to schedule all of the reports (whether PIX or Windows) but only those reports will be
generated whose license is valid. So, for example, you have PIX Reporting Module
license with you, then you will be able to access the screen shown below and
configure all of the reports but Job Manager will only generate those reports that are
PIX and will not generate any of the configured Windows Report since you dont have
the license for it.

Job Manager bases on so-called profiles. You can associate different reports to
different profiles and they will be generated according to your specified time and date.
You can create as many profiles as you like which means that you can generate the
same report as many times as you would like in one day.
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Job Manager can also generate those reports that you have saved in the Reporting
Module by applying various filters. The reports that are indented in Figure 2 are those
reports that had been saved using Report Manager (in our example there is only one
saved report).

Job Manager helps you in generating reports on specified days and times. For
example, you can tell Job Manager to generate the System Status report at 7:00 am
on monday, tuesday and friday. Now, every time you come to office, you will see a
complete report on your system on the above mentioned days and you can take
necessary actions right away.

To access the client of Job Manager that makes settings for different reports, click on
Options button on the main tool bar and then press "Job Manager Settings".

If you have no configured reports at this time, you will see a message box similar to
the one shown below:

Figure 1: No configured reports...

No configured reports available

If you have not configured any report yet, it makes no sense to open up the
JobManager, so this popup will remind you that you have no reports configured and
asks you if you want to switch to the ReportManager now, to configure your custom
reports.

Otherwise you will see a dialog like this:
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Figure 2: Job Manager Form (General Tab)

JM form will show all the available reports on the left side of the form in a list view.
Select the list from this listbox and use other tabs to specify different settings.

Back

Takes you to the previous tab, if any.

Next

Takes you to the next tab, if any.

Save

Saves the settings and restart the service only if it was already running. If it was not
running, then it asks you if it should start the service.
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Save & Close

Saves the settings and restart the service only if it was already running. If it was not
running, then it asks you if it should start the service. After that the box will be
closed.

Close

Closes the dialog box.

Selected Profile

All of the settings will be applied to the selected profile. You can create, update or
delete the profiles by clicking on "Edit Profiles" button. You can create different
profiles and associate the same report with that particular profile. In this way, you
can schedule the generation of the same report at different times according to the
settings that you have done in that profile.

Edit Profiles

This link opens up the following dialog box:

Figure 3: Job Manager Profiles
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Existing Profiles: This list displays a list of existing profiles.

Name: Name of the profile.

Description: Description of the profile.

Insert: Inserts a new profile.

Update: Updates the selected profile.

Delete: Deletes the selected profile.

Close: Closes the Profile window.

Note:
If you feed the JobManager with lots of configured profiles and reports it gets very
slow for restart after a while. As advice: keep it simple and put. Further note that the
Job Manager Service is only stopped or running if the buttons at the bottom right of
the Console window are not all grey.
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3.2.4.4.1  General Tab

Figure 1: Job Manager Form (General Tab)

UTC Offset (minutes)

Using this you can specify the UTC offset of your locale in minutes. Please note that if
you have logged the data in the file or in the database using Local Time and not as
UTC time, then you should set this to zero (as shown above)

Job Manager Interval

It is the interval after which the Job Manager will wake up and look for the reports
that are to be generated. If it finds that its time to generate a particular report, it
generates it and goes to sleep again. If it doesn't find any report scheduled for that
time, then it goes into sleep again and wakes up again after this interval.
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3.2.4.4.2  Action Tab

Figure 1: Job Manager Form (Action Tab)

File Prefix

"File Prefix" is the prefix that you want to append to the complete file name
(Complete file name also includes the current date and time on which the report is
generated. This is appended by the application).

You can specify in this tab that whether you want to save the report that will be
generated on the specified time on the hard disk or you want to attach this report as
an attachment and send it to someone.

Send as attachment in email

If you want to send this report as email, select the upper radio button and press the
SMTP settings button. It will ask for the server name (Figure 2). Write the server
name over there.
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Figure 2: SMTP Settings Form

Then press the Message Settings button. It will open up another dialog box (Figure 3)
with information like To, CC, BCC, Subject, and Message etc. Fill in the required
information and press ok.
Note: From field is mandatory in the "send as attachment in email",
otherwise it will not work.

Figure 3: Message Settings Form

Save as file

If you want to save this report on the hard disk locally, select the lower radio button
and press the File Settings button. Select the path on which you want to save the file
and press ok.



103Using MonitorWare Console

© 2006 Adiscon GmbH

3.2.4.4.3  Schedule Tab

Figure 1: Job Manager Form (Schedule Tab)

In this tab, you can specify on which days the selected report should run and at which
time. For example, in the above figure, Report "last 24h report" is scheduled to run
every day at 12:00 PM.

Re-run when JM starts next time

If you dont select "Re-Run when JM starts next time" a job generated once in a day
will not be generated again within that day but if you select this option it will generate
again. You have to select this option each time you like to generate a report that has
been already generated within the day.

Here you have to save your settings before moving ahead else your settings will not
be saved and executed.
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3.2.5 The Knowledge Base Module

Knowledge Base Manager is a very useful component of MonitorWare Console. It
contains a collection of articles that are related either with one or more devices or
with one or more event rows. With the passage of time, the user can enhance the
articles repository by adding articles to it. This repository will help the user during
troubleshooting.

3.2.5.1 Knowledge Base Manager

When the Knowledge Base Node in the tree view is clicked, Knowledge Base Manager
would open up as shown in the figure:

Figure 1: Knowledge Base Manager

Knowledge Base Manager displays the complete repository of Knowledge Base articles
that have been added by various users so far. For each article, it displays its code,
title, category, created by, supplied by, created at, last update and last updater.

Edit Link

If Category combo box is to be updated, edit link is pressed and it opens up a small
form, as shown below, which can be used to insert, update or delete a category.

Figure 2: Knowledge Base Category Form

New Button

When this button is pressed, a small form as shown below is displayed, in which the
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user can enter the URL and its description.

Figure 3: URL Form

Note: Start URL with appropriate protocol header e.g. http://, ftp:// etc or start the
URL with www.

Edit Button

Select at most one URL and click the edit button. It will open up the same form as
displayed above. User can modify this URL using this button.

Delete Button

Select the check boxes near the URLs and press this button. This will delete all
selected URLs from this article.

3.2.5.2 Editing a Knowledge Base Article

To edit a Knowledge Base Article, A Knowledge Base Article can be opened for editing
in one of the following four ways:

1.) Select at most one article at a time and then press the add button in the
tool bar of Knowledge Base Manager.

2.) While the focus is on some article, press Enter key.
3.) Right click on any article, and click Update
4.) Double click on any article.

Once any of the above-mentioned steps has been performed, a form for that
Knowledge Base Article would open up as shown in the following figure:
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Figure 1: Knowledge Base Article Form

In this form user can make the changes in all the fields except for the KB Code,
Created At and Last Update field because all of them are automatically generated.

3.2.5.3 Deleting Articles

Deleting a specific Article

A specifc article can be deleted in one of the following three ways:

1.) Select an article and press the delete key on the keyboard.
2.) Right click on an article and click delete.
3.) Select an article and click on delete button in Knowledge Base Manager's

tool bar.

Deleting all Knowledge Base Article

All the Knowledge Base Articles can be deleted by using one of the following options:

1.) Click the Delete All button in the tool bar.
2.) Right click on the list view in Knowledge Base Manager and click on delete

all.

3.2.5.4 Refreshing Articles

Knowledge Base Manager can be refreshed in one of the following three ways.

1.) Click the refresh button in Knowledge Base's tool bar.
2.) Press F5 key from the keyboard.
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3.) Right click on list view and click on refresh.

This action will update the Knowledge Base Manager from the database. In other
words: if another user has added some knowledge base articles, they would also be
visible for you after this action.

3.2.6 Network Scanning Tools

With the purchase of this module's license, you will have 3 Network Scanning Tools:

1.) Ping Tool
2.) TraceRoute Tool
3.) PortScan Tool

3.2.6.1 Ping Tool

This tool can be used to ping a host over the ICMP Protocol. It can be accessed either
using the Tools -> Network Tools menu or by right clicking a device in the left tree-
view. It contains a few options that are similar to the ones that are in the system ping
command. The Ping Dialog can be opened multiple times, so you can run multiple
pings at the same time. For details, see the screenshot below:

Ping Settings Form
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IP /Hostname

The hostname or IP Address which you wish to ping.

Count

The number of Pings you want to do. Enter zero for continuous pinging.

BufferSize

The data size, which is sent to the target. By default, this is 32 bytes. This can be up
to 10240 bytes (10 Kbytes).

TimeOut

The value in milliseconds for which the ping waits for a response from the target. Its
maximum value can be 60000 milliseconds.

Sleep between Pings

Just like the real System Ping command, you can specify a wait time between each
ping. This can be a maximum of 60000 milliseconds.

Ping

Hit this button to start the ping operation. Once started, you will be able to abort it by
clicking the cancel button or closing the window.

Cancel

Use this button to abort the ping operation.

3.2.6.2 TraceRoute Tool

The TraceRoute Tool is similar to the "tracert system command" of Windows.
TraceRoute is the program that shows you the route over the network between two
systems, listing all the intermediate routers a connection must pass through to get to
its destination. It can help you determine why your connections to a given server
might be poor, and can often help you figure out where exactly the problem is. It also
shows you how systems are connected to each other, letting you see how your ISP
connects to the Internet as well as how the target system is connected.

It can be access either using the Tools -> Network Tools menu or by right clicking a
device in the left tree-view. You can use it to trace back all hops between your
machine and a remote machine. The results are displayed in a Listview, and you can
see detailed output in a large textbox at the bottom part of the window. It contains a
few options that are similar to the ones that are provided in the System tracert
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command. The TraceRoute Dialog can be opened multiple times, so you can run
multiple tracerts at the same time. For details, see the screenshot below:

Figure 1: TraceRoute Form

IP / Hostname

The hostname or IP you want to TraceRoute.

Maximum hops

The maximum number of hops you want to trace. Default is 25, and it is very seldom
that this value is reached.

TimeOut

The value in milliseconds for which the TraceRoute waits for a response from the hop.
This can be a maximum of 60000 milliseconds.
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Resolve hostnames

If enabled, the TraceRoute tries to resolve the DNS name of each hop.

TraceRoute

Hit this button to start the TraceRoute operation. Once it starts, you can abort it with
the cancel button, or by closing the window.

Cancel

Use this button to abort the TraceRoute operation.

3.2.6.3 PortScan Tool

The PortScan tool is a very powerful tool to check open ports of a target machine. It
can be accessed either using the Tools -> Network Tools menu or by right clicking a
device in the left tree-view. The results of the PortScan are added into a Listview with
the port number, a description (if available), a response (if there is any) and the time
that a particular scan took. Additionally, there is a textbox at the bottom of the
window, which displays more detailed information. The PortScan Dialog can be
opened multiple times, so you can run multiple PortScans at the same time. For
details see the screenshot below:
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Figure 1: PortScanner Form

IP / Hostname

The hostname or IP you want to scan for open ports

Connect TimeOut

This value in milliseconds is used for send/receive operations on open ports. It is also
used for a Timeout when trying to connect to ports.

Every Port in the Portlist

When this option is selected, all ports from a common list will be scanned. To
view/edit this list, see the Portlist setup.

Selected Ports from the List

If this option is selected, only selected ports from the common Portlist will be
scanned. To view/edit this list, see the Portlist setup.
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All Ports from

This option is used to give a Range of ports to scan. This means to scan all ports from
a Start value and an End value. By default, this is 1 to 65535, which means every
possible port will be scanned.

Send Data to common ports

If enabled, the PortScan tries to send messages to found open ports. For example on
Port 80, it tries to send a standard GET request.

Reverse Lookup

Use this function to get the DNS name of an IP (if possible).

Connections Slider

This slider will set the number of parallel connections that will be used for the
PortScan. By default, this value is set to 10, which is rather low. You can increase this
number from 1 to 250. Be careful with the high connection-scans (like 250). Some
DSL Routers, or slow dialup links can be "killed" by such a high connection scan. This
includes the scanning side as well as the side that is scanned!
However, more connections mean faster results, but also more data (traffic) per
second.

PortScan

Hit this button to start the PortScan operation. Once started, you can abort it by
clicking the Cancel button or closing the Window.

Cancel

Use this button to cancel a PortScan operation. Please be patient after you have
clicked this button. Depending on how many connections you are using, it can take a
while until all scans are stopped.

Portlist Setup

Use this button to view or edit the common Portlist. In this list, you will see well-
known ports including a description and a checkbox for each port. Use the checkboxes
to define which ports should be scanned during a "Selected Ports from the List"
PortScan. See the screenshot below for more details:
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Figure 2: PortScan List Editor Form

Save

Hit the save button to save changes (If you selected or deselected any ports).

Cancel

This will just do the same as if you close the window. Changes that were made will be
discarded and the window will be closed.

4 Getting Help

In the event you experience problems, find here how to solve them.

Please note that all options (except priority support) are also open to evaluating
customers. So do not hesitate to try them. Help is available in English and German
language. Our local resellers may provide local language support. Please check with
them.

Frequently asked Questions
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For a current list of Frequently Asked Questions (FAQs), please visit
http://www.mwconsole.com/en/FAQ/. The FAQ area is continuously being updated.

MonitorWare Console Web Site

Visit the support area at  http://www.mwconsole.com for further information. If for
any reason that URL will ever become invalid, please visit www.adiscon.com for
general information.

Support Forum

Share questions and answers with your peers! The forum is also monitored by Adiscon
support staff. To access the forum, point your browser at
http://forum.adiscon.com/forum,2.html.

Customer Support System

Our customers service and support system is available at
http://custservice.adiscon.com. With it, you can quickly open a support ticket via a
web-based interface. This system can be used to place both technical support calls as
well as general and sales questions. We would appreciate if you select the appropriate
category when opening your ticket.

Please note: the customer service system asks you for a userid and password when
you open it. If you do not have a userid yet, you can simply follow the "register" link
(in the text part) to create one. You can also open a ticket without registering first, in
which case the system will create one for you. You will receive the generated userid
as part of the email notifications the system generates.

Why using the customer support system? As you see further below, we also offer
support by email. In fact, email is just another way to create a ticket in the customer
support system. Whenever we reply to your ticket, the system automatically
generates an email notification, which includes a link to your ticket as well as the
answer we have provided. So for the most cases, you can use email, only. However,
there are some situations where the support system should be used:

· If you seem to not receive responses from us, it is a very good idea to
check the web interface. Unfortunately, anti-SPAM measures are being setup
more and more agressive. We are noticing an increasing number of replies that
simply do not make it to your mailbox, because some SPAM filter considered it to be
SPAM and removed it. Also, it may happen that your support question actually did
not get past our own SPAM filter. We try very hard to avoid this. If we discard mail,
we send a notification of this, so you should at least have an indication that your
mail did not reach us. Using the customer support system via its own web interface
removes all SPAM troubles. So we highly recommend doing this if communication
otherwise seems to be distrubed. In this case, please remember that notification
emails may also get lost, so it is a good idea to check your ticket for status updates
from time to time.

http://www.mwconsole.com/en/FAQ/
http://www.mwconsole.com
http://www.adiscon.com/en/
http://forum.adiscon.com/forum,2.html
http://custservice.adiscon.com
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Subscription

We have set up an announcement mailing list for MonitorWare Console. It will carry
news on upcoming releases and hotfixes. It is a low-volume list and we guarantee it
will NOT send any marketing via it (except, if you consider a new release
announcment as marketing ).

You can subscribe yourself at: http://lists.adiscon.net/cgi-
bin/mailman/listinfo/mwcon

Email

Please address all support requests to support@adiscon.com. An appropriate subject
line is highly appreciated.

Online Seminars

Adiscon offers a selection of online seminars. This selection is continuously being
expanded. All available seminars can be found at
http://www.adiscon.com/Common/SeminarsOnline/

Please note: Windows Media Player is required to view the seminars.

Phone

Phone support is limited to those who purchased support incidents. If you are
interested in doing so, please email info@adiscon.com for further details.

Fax

Please direct your faxes to:

+49-9349-928820

Toll free in the US: 1-888-900-3772

with "+" being the international dialing prefix, e.g. 011 in the US and 00 in most
other countries.

Software Maintenance

Adiscon's software maintenance plan is called UpgradeInsurance. It offers unlimited
free upgrades and priority support during its duration. It can be purchased for a
period between 1 and 5 years.

To learn more about UpgradeInsurance, please visit:

http://www.adiscon.com/Common/en/products/upgrade-insurance-details.asp

http://lists.adiscon.net/cgi-bin/mailman/listinfo/mwcon
http://www.adiscon.com/Common/SeminarsOnline/
http://www.adiscon.com/Common/en/products/upgrade-insurance-details.asp
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Non-Technical Questions

Please address all non-technical questions to info@adiscon.com. This email alias will
answer all non-technical questions like pricing, licensing or volume orders.

Please note: we have increasingly often problems with too-agressive SPAM filtering,
resulting in loss of our replies. If you do not receive a response from us within two
working days latest, we highly recommend re-submitting your question via the
customer support system.

Product Updates

The MonitorWare line of products is being developed since 1996. New versions and
enhancements are made available continuously.

Please visit www.mwconsole.com for information about new and updated products.

5 Exception Handler

If MonitorWare Console experiences unexpected problems, it throws a so-called
exception. This will cause the window shown below to appear. That window contains
the problem cause in very technical terms. If the message does not make sense to
you, you can email it to Adiscon support. To do so, press the "Send Email" button. Be
sure to enter some information on what you did when the problem occured. Enter that
into the comments field. Problem reports without a comment can not be mailed.

Figure1: An Exception occured...

http://www.mwconsole.com
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Otherwise, error report can not be sent. In this case a notification is shown either if
the Comments field is empty or the input is too short.

Figure2: No Message or Message too short...

Below, see the descriptions of the fields and buttons in the Exception Handler form:

Message
Description of the exception.

Details
Some further information about the error. Helpful to get a deeper understanding for
what reasons the exception occurred.

Comments
Here you can enter some comments which you want to send to our support team. It is
highly appreciated to write down the steps you have done before the exception was
thrown.

Clipboard
Press this button to copy the contents of the message and details fields into your
clipboard.

Send Email
After entering some comments for our support team press this button in order to send
an email to us.

Close
Closes the exception handler form.

6 Purchasing MonitorWare Console

All MonitorWare Console features can be used for 30 days after installation without a
license.

The License

The end user license agreement is displayed during setup. If you obtained a ZIP file
with the product, there is also a file license.txt inside that ZIP file. If you need to
receive a copy of the license agreement, please email info@adiscon.com.

Pricing & Ordering



118 MonitorWare Console

© 2006 Adiscon GmbH

Please visit http://www.mwconsole.com/en/intermediate-order.asp to obtain pricing
information. This form can also be used for placing an order online. If you would like
to place a purchase order, please visit
http://www.adiscon.com/Common/en/OrderByPO.asp to obtain details.

If you would like to receive assistance with your order or need a quote, please contact
info@adiscon.com.

7 References

The following links will help you in getting further information on MonitorWare
Console

· MonitorWare Console Main Web Site
· Windows' Reports Description
· PIX's Reports Description
· Version History

8 Copyrights

Adiscon GmbH copyrights this documentation as well as the actual MonitorWare
Console product. To learn more about other Adiscon products, please visit
www.adiscon.com/en/products/.

Please note that MonitorWare Console is part of the MonitorWare line of products.
Please visit the MonitorWare site www.monitorware.com to receive updates and
information on all members of the family. The site also does have information on
combining the individual components to build a complex distributed configuration.

We acknowledge using these following third party tools. Here are the download links:

SharpZipLib -0.84:    http://www.icsharpcode.net/OpenSource/SharpZipLib/

Microsoft, Windows, and the Windows logo are trademarks, or registered trademarks
of Microsoft Corporation in the United States and/or other countries.

Other mentioned trademarks are for reference only. They belong to their respective
owners.

9 Glossary of Terms

The Glossary of Terms is also available on the Web:

http://www.monitorware.com/Common/en/glossary/

The web version most probably has more and more up-to-date content. We highly
encourage you to visit the web if in doubt.

http://www.mwconsole.com/en/intermediate-order.asp
http://www.adiscon.com/Common/en/OrderByPO.asp
http://www.mwconsole.com/
http://www.mwconsole.com/en/Product/reports.asp
http://www.mwconsole.com/en/Product/pix-reports.asp
http://www.mwconsole.com/common/en/version/mwconsole.asp
http://www.adiscon.com/en/products/
http://www.MonitorWare.com
http://www.icsharpcode.net/OpenSource/SharpZipLib/
http://www.monitorware.com/Common/en/glossary/
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9.1 EventReporter

EventReporter is Adiscon's solution to forward Windows NT/2000/XP event log entries
to a central system.
These central systems can be either WinSyslog's, other Syslog daemons (e.g. on
UNIX) or MonitorWare Agents. EventReporter is part of Adiscon's MonitorWare line of
products.

Click here for more Information about EventReporter.

9.2 Millisecond

A millisecond is a thousand of a second. It is abbreviated as "ms". As such, 500ms
mean half a second.
Inside the MonitorWare line of products, many timers are expressed in milliseconds as
a fine control over the services and actions is provided to the administrator.

Click here for more Information about Milliseconds.

9.3 Monitor Ware Line of Products

Adiscon's MonitorWare line of products includes monitoring and operations
management tools. It consists of several components, each of which can be used
either individually or as a complete solution. As of this writing, the following products
are available:

· Adiscon Logger (www.monitorware.com/en/logger/)
· ActiveLogger (www.activelogger.com)
· EventReporter (www.eventreporter.com)
· IISLogger (www.iislogger.com)
· MoniLog (www.monilog.com)
· MonitorWare Agent (www.mwagent.com)
· MonitorWare Console (www.mwconsole.com)
· WinSyslog (www.winsyslog.com)

There is also an open source syslog library available for programmers whishing to
integrate syslog into their C/C++ programs:

· Liblogging (www.liblogging.org)

New products are continously being added - please be sure to check
www.monitorware.com from time to time for updates.

Click here for more Information about the MonitorWare Line of Products.

http://www.eventreporter.com
http://www.adiscon.com/en
http://www.winsyslog.com/en/index.php
http://www.mwagent.com/en/index.php
http://www.monitorware.com/Common/en/glossary/eventreporter.php
http://www.monitorware.com/Common/en/glossary/Millisecond.php
http://www.adiscon.com/en/
http://www.monitorware.com/en/logger/index.php
http://www.activelogger.com/en/index.php
http://www.eventreporter.com/en/index.php
http://www.iislogger.com/en/index.php
http://www.monilog.com/en/index.php
http://www.mwagent.com/en/index.php
http://www.mwconsole.com/en/index.php
http://www.winsyslog.com/en/index.php
http://www.liblogging.org
http://www.monitorware.com/en/index.php
http://www.monitorware.com/Common/en/glossary/MonitorWare-Line-of-Products.php
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9.4 Resource ID

The Resource ID is an identifier used by the MonitorWare line of products. It is a
simple, administrator assigned string value. It can be used to correlate different
events - even from different source - to a specific resource.
For example, on a Windows server running Microsoft Exchange, all Exchange events
could be assigned to a resource id of "Exchange Server".

In MonitorWare Agent 1.0 and WinSyslog 4.0 support for Resource IDs is limited. The
field is present and can be persisted to the database or stored in XML files, but
besides this there is no value in it.

Later releases of the MonitorWare Line of Products will much broader support the
Resource ID.

Click here for more Information about the Resource ID:

9.5 SMTP

The "Simple Mail Transfer Protocol". This is an Internet standard for sending email
messages. Virtually all major email systems are either based on SMTP or at least offer
gateways to SMTP capable systems.

SMTP is used for sending email. It can not be used to pick up email messages. For
this purpose, protocols like POP3 or IMAP4 are required.

SMTP is highly standardized. As such, a standard email client can work with all SMTP
compliant servers. In the public Internet, almost all providers offer SMTP compliant
mail servers for their customer's use.

Click here for more Information about SMTP.

9.6 SETP

SETP is the "Simple Event Transfer Protocol". SETP allows reliable delivery of events
between SETP supporting systems. EventReporter, WinSyslog and MonitorWare Agent
support SETP. EventReporter works as SETP Client Only. As such, it can forward
events generated and gathered by them to central or intermediary SETP servers.
WinSyslog EnterPrise Edition works as SETP client and server, only. The MonitorWare
Agent can operate both as a SETP server and client and as such also as a relay. It
plays a vital role in a complex, distributed environment.

SETP was developed for MonitorWare. It allows synchronous communication between
SETP clients and servers. With SETP, an event can be forwarded exactly as it was on
the original event generating system. For example, if a syslog message is received on
a remote system, that exact syslog message can be forwarded via as many SETP
relays as is configured. During that relaying, no information from the original

http://www.mwagent.com/en
http://www.winsyslog.com/en
http://www.monitorware.com/Common/en/glossary/Resource-ID.php
http://www.adiscon.com/Common/en/glossary/SMTP.php
http://www.eventreporter.com/en/
http://www.winsyslog.com/en/
http://www.mwagent.com/en/
http://www.monitorware.com/Common/en/products/winsyslog5-editions.php
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message is altered or lost.  As such, each of the relays as well as the final SETP server
will see the original source address, time stamps and message.

Furthermore, SETP guarantees reliable delivery. It is based on TCP, so each of the
SETP peers know exactly that the communication partner can successfully receive and
process the message. SETP guarantees that new events are only forwarded after the
previous ones were successfully received and processed. SETP also checks for on the
wire errors. Due to its characteristics, SETP can successfully be used in barely or
occasionally connected environments like radio connected systems.

The SETP design is influenced by many industry standard movements, most notably
the BEEP protocol and XML. However, SETP is optimized to have a very lightweight
footprint. As such, it can be implemented even in low powered devices with little
overhead.

Click here for more Information about SETP.

9.7 Syslog Facility

Syslog Facility is one information field associated with a syslog message. It is defined
by the Syslog protocol. It is meant to provide a very rough clue from what part of a
system the message originated from. Tradidionally, under UNIX, there are facilities
like KERN (the OS kernel itself), LPD (the line printer daemon) and so on. There are
also the LOCAL_0 to LOCAL_7 facilities, which were traditionally reserved for
administrator and application use.

However, with the wide adaption of the syslog protocol, the facility field contents has
become a little less clear. Most syslog enabled devices nowadays allow configuring
any value as the facility. So it is basically left to distinguish different classes of syslog
messages.

The facility can be very helpful to define rules that split messages for example to
different log files based on the facility level.

Click here for more Information about Syslog Facility.

9.8 TCP

A reliable IP transport protocol. TCP communication ensures that no packets are lost
in transit. As such, it is most useful in low-bandwidth or unreliable environments.
Examples are slow WANs or packet radio networks.

Click here for more Information about TCP.

http://www.monitorware.com/Common/en/glossary/beep.php
http://www.adiscon.com/Common/en/glossary/SETP.php
http://www.monitorware.com/en/topics/syslog/
http://www.adiscon.com/Common/en/glossary/Syslog-Facility.php
http://www.adiscon.com/Common/en/glossary/TCP.php
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9.9 UDP

A non-reliable IP transport protocol. It provides best effort delivery. Typically, in LAN
environments UDP packets are never lost. However, in WAN scenarios or with heavily
loaded LANs, UDP packets might be lost.

Click here for more Information about UDP.

9.10 Upgrade Insurance

UpgradeInsurance is Adiscon's software maintenance plan. It offers free major
upgrades as well as priority support. UpgradeInsurance is available for all Adiscon
products and can be purchased for a period between 1 and 5 years.

Click here for more Information about Upgrade Insurance.

9.11 UTC

UTC is the so-called "universal coordinated time". UTC was formerly referred to as
"GMT" (Greenwich Mean Time) and is the basis of the international time zone system.
For example, New York, USA is 5 hours behind UTC. So if it is 12 noon in New York,
the UTC time is 5pm.

The MonitorWare line of products often uses UTC. UTC has the fast advantage of
providing one consistent time notation, even if devices are across multiple time zones.
This is extremely valuable if a centrel location is to consolidate events from senders in
multiple time zones.

Using UTC might not be appropriate if a whole system is contained within a single
time zone. As such, most time parameters inside the MonitorWare line of products can
be configured to work with local time instead of UTC.

Click here for More Information about UTC.

http://www.adiscon.com/Common/en/glossary/UDP.asp
http://www.adiscon.com/en/
http://www.adiscon.com/Common/en/products/upgrade-insurance-details.php
http://www.adiscon.com/Common/en/glossary/UTC.php
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